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Introduction

Congratulations and thank you for buying the Sony Ericsson GPRS / Wireless LAN PC Card GC79.

The GC79 is a combined wireless LAN (WLAN) adapter and triple band GSM product that
enables you to communicate wirelessly from your laptop on all five continents, in over one hundred
and sixty countries. As the GC79 provides wireless communications you no longer need to carry
cables, telephone jack converters, chargers and batteries. The GC79 is very simple to install and use;
the software provided allows you to select the best data service available so that the GC79 is always
available for data transfer.

The GC79 enables your laptop PC to:

* Connect to your corporate network

* Browse the Internet

» Send and receive e-mails

* Receive information services in real time

* Access files, databases and discussion groups
* Send and receive SMS text messages

+ Edit SIM card entries

Note:
Before using your GC79 you MUST read Important Information on page 60.

The GC79 wireless LAN facilities can be used wherever there are connection “hotspots”. Wireless
LAN hotspots are becoming increasingly common in both public places, such as hotels and airports
(allowing Internet connection), and within offices (providing connections to corporate networks).

The GC79 GSM/GPRS facilities provide almost worldwide portable modem access to the Internet
or to corporate networks.

Hardware Overview

SIM Card

The GC79 is a standard 32 bit type II PC card with a 15mm extension which contains the GSM
and WLAN antennas.

The amount of power drawn from the laptop battery is dependant upon a number of factors including
status, frequency band, distance to GSM base station and number of timeslots used. See Technical
Specifications on page 63 for a general guide to power consumption.

When you subscribe to a mobile network operator, you are issued with a SIM card (Subscriber
Identity Module card). The SIM contains your personal subscriber data. You need a SIM to use
your GC79.
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Software Overview

GC79 Manager

You can use the GC79 Manager to:

*  View GSM/GPRS and wireless LAN status information
* Create or modify connection settings

* Connect to the Internet or a corporate network

*  Manage GC79 settings

* Manage SIM card and PC phone books

* Send and receive SMS messages

Using the GC79 with your Applications

Data Programs
You can use the GC79 as a connector to a wireless LAN access point or to provide Intranet/Internet
connectivity for a wide range of applications.

The GC79 can also be programmed at command level by application developers; for more details
see the AT Commands Manual.

Fax Programs

You can use the GC79 as a fax provided you have the correct software, e.g. Microsoft Fax
(supplied with Windows 2000 and XP).

Documentation

lllustrations

The GC79’s documentation is designed to enhance your understanding of its capabilities.
The following guides are provided:

* A printed Quick Start Guide aimed at getting you operational as quickly as possible.

* An online User’s Guide (this document) containing a comprehensive description of the GC79
functionality. You can read the guide on the computer screen or print it on to either European A4
or American Letter sized paper.

* An online AT Commands Manual, aimed at application developers, containing a full list of all
the modem commands that can be used with GC79. The manual can be read online or printed
in the same way as the User’s Guide.

The User’s Guide and the AT Commands Manual are located on the GC79 CD-ROM as Adobe
Acrobat PDF files. The GC79 CD-ROM also contains Adobe Acrobat Reader® which you can
install if necessary.

The illustrations in this manual were obtained using the GC79 on a Microsoft Windows® 2000
operating system. The dialogs that appear on your PC may differ depending on the version of
Windows in use.
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Getting Started

Checklist

Make sure the following items are in the box when you unpack it:
e Protective case for storing the GC79

* GC79 PC Card

*  Quick Start Guide

« CD-ROM
The CD contains: drivers, software, documentation and a readme file.

System Requirements

This section lists the network subscriptions, hardware and software requirements for running
the GC79 PC Card.

Wireless LAN Connection

In order to use your GC79 as a wireless LAN adapter for a corporate network, you must have the
appropriate access and log-on rights. Contact your corporate IT support function to arrange access.

For access to the Internet, you will require the appropriate subscription or one-off usage login from
your service provider.

GSM Network and Subscription
The GSM network services you use in conjunction with your GC79 depends on the subscriptions
your network operator can provide. Contact your network operator or service provider to make sure
the options you require are available. Make sure that data options are included in your subscription,
as these are usually optional services.

Note:
Mobile operators often provide a number of connectivity options via GPRS such as WAP and
Internet, so check that the Internet or VPN service you require is enabled for your subscription.

The functionality of the different subscriptions available from networks operators are discussed
below:

Circuit Switched Data (CSD)

CSD is the original GSM network data transfer method, used in the past for WAP. Almost all
GSM networks have this capability at 9.6 kbps. It is possible for the network to upgrade the speed
to 14.4 kbps. The GC79 operates at this higher speed where available.
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Hardware

Software

High Speed Circuit Switched Data (HSCSD)

HSCSD is an enchanced GSM network capability offered by some network operators. It enables
circuit switched data connections to run at a higher data speed, using more than one wireless
‘timeslot’ for the data transmission. This is ideal for providing a faster connection to existing
corporate or ISP dial-up facilities. The preferred connection speed is selected when you define
the connection using the Connection Wizard.

General Packet Radio Service (GPRS)
GPRS is a new network connection which provides “always on” mobility. The connection set up
is fast and, once connected, applications may send and receive data whenever required. In today’s

GPRS networks, the GC79 receives data at speeds up to 53.6 kbps and transmits at speeds up
to 26.8 kbps.

Short Message Service (SMS)
The PC can send and receive SMS text messages using the SMS Messages screen in the GC79
Manager, see GC79 Manager SMS Messages Screen on page 48, for more details.

You will need:

* A PC that has the minimum specification recommended by Microsoft to run the version of
Windows® installed on it.

* A 32 bit type II PC Card slot.
* Sony Ericsson GPRS / Wireless LAN PC Card GC79.
* A SIM card.

You will need:

«  Windows® 98SE, Me, 2000 (SP2) or XP.

» Sony Ericsson GC79 Manager CD-ROM (or files downloaded from the Sony Ericsson support
website: www.SonyEricsson.com/support).

Services Available Over the Internet

The Sony Ericsson web site contains support to facilitate easy communications and rapid
information retrieval, wherever you are. It gives you access to online customer services,
online user manuals, software downloads, and useful information. The address is:

http://www.SonyEricsson.com/support

Sony Ericsson’s M2M home page address is:
http://www.SonyEricsson.com/m2m

General information on wireless LAN can be obtained from:

http://www.wlana.org
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Installation

The GC79 Manager CD-ROM contains the software required to operate your GC79. The software is
simple to set up and operate.

The CD-ROM contains the following software:
*  GC79 Manager

» User Documentation

*  On-line Help

* ReadMe text file containing the latest information about the GC79

Before you Begin

Before you begin, you will need to ensure that you have access rights to your corporate network for
wireless LAN connections.

You will also need to make sure that the GSM services you require are included on your SIM card
subscription. For an explanation of the services that are available see GSM Network and Subscription
on page 8. Contact the organisation that supplied you with your SIM card and request that the
specific services (GPRS, HSCSD, CSD or SMS) you require are added to your subscription.

GC79 Hardware Set Up

10

Remove your GC79 card from its protective cover.

2. Place the SIM card into the slot on the back of the GC79.

Note:

The cut corner of the SIM card must be placed into the SIM slot as demonstrated below,
the SIM contacts should face downwards.

e =

S

If you want to use your other PC card slot remove the GC79 whilst you insert the other card.
See Safe Removal of the GC79 on page 20 for more details.

When the GC79 isn't in use it is recommended that you store it in the protective carrier provided.

Installation



Installing the Software

1. Insert the GC79 Manager CD-ROM in your CD drive. After a few seconds a Sony Ericsson
splash screen is displayed.

Note:
If the CD-ROM does not autorun, select Start Run and type D:\Setup.exe into the Run
dialog. (Where D is your CD drive.)

2. The Choose Language dialog opens. Click on the drop down list and select the installation
language for your GC79 software. Click OK.

3. The InstallShield Wizard for Sony Ericsson GC79 Manager opens; follow the instructions on
screen. When installation is complete click Finish.

4. Insert the GC79 PC Card. Make sure the GC79 is fully inserted.

<=
@Q&/
=

=

5. After a few seconds, the New Hardware Wizard opens and installs the necessary drivers onto
your PC from the GC79 CD. The wizard may require you to locate a specific driver file. If this
happens a dialog opens, click Browse and select:

Component GC79 CD-ROM Location

GPRS Drivers on a D:\Driver\Driver98
Windows 98SE machine

GPRS Drivers on a D:\Driver\DriverME
Windows ME machine

GPRS Drivers on a D:\Driver\Driver2k
Windows 2000/XP machine

Wireless LAN Driver (bcmwl5.inf)ona | D:\wlan
Windows 2000/XP/ME machine

Wireless LAN Driver (bcmwl5a.inf) on D:\wlan
a Windows 98SE machine

In the above table D is referred to as your CD drive.

6. Select the driver file requested by the Wizard and click Open. The Hardware Wizard finishes
the installation.

Note:
This procedure must be repeated if, in the future, the card is inserted into a different PC Card
slot in your PC.

7. Select Programs =+ Sony Ericsson = GC79 Manager to start using your GC79. The GC79
and GC79 Manager are ready for use.
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Start Using GC79 Manager

. To start GC79 Manager select Start =+ Programs = Sony Ericsson = GC79 Manager

or select your desktop shortcut E

. If requested, enter your SIM Card/Phone Lock PIN and click OK. It is only necessary to enter

the PIN number once during a PC session.

You are allowed three attempts to enter the correct PIN code. If you fail to enter the SIM PIN
correctly, the SIM is blocked; and if you fail to enter the Phone Lock PIN correctly, your GC79
is locked. Contact your GSM network operator for details of how to unlock it.

To set the SIM Card PIN and Phone Lock PIN, see Locks on page 38.

. The Radio dialog opens, select the required state for your GC79 GSM/GPRS radio transmission.

See GC79 Manager GSM/GPRS Preferences on page 16 for more details.

. The GC79 Manager opens, displaying the Status screen. Connectivity details are displayed

on this screen. GC79 Manager Status Screen on page 35, for more details.

. The GC79 Manager icons are displayed in the system tray of your PC.

GC79 Manager Icons

12

The GC79 Manager icons, displayed in your desktop system tray, allow you to view the current
status of the GC79. Simply place your mouse cursor over an icon to display text.

Some of these icons have menus associated with them. See Icon Menus on page 14 for details.
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GSM/GPRS Icons

Wireless LAN Icons

W
b
|,

Windows Icons

GSM/GPRS radio is disabled.

The GSM/GPRS radio transmitter is enabled, but there is no GSM
or GPRS service available.

GC79 Manager is waiting for the GC79 card to be inserted.

The GC79 has GSM service and indicates a signal strength of 3 out of
5 bars. CSD, HSCSD, SMS and fax may be used, provided these are
supported by the subscription. GPRS is not available.

The GC79 has GSM and GPRS service. GPRS, CSD, HSCSD, SMS
and fax may be used, provided these are supported by the subscription.

Wireless LAN radio is disabled.

The wireless LAN radio transmitter is enabled, but there is no network
available.

The GC79 has made a wireless LAN network connection. The degree
to which this icon is green indicates the signal strength.

v [y o W TR

In addition, the following standard Windows® operating system icons also appear in the system
tray when the GC79 is inserted in your PC and in use.

ey

Active Windows dial-up or wireless connection. Hover your mouse

over the icon or double click it to display information about the network
connection (e.g. number of bytes sent/received). Up to two of these icons
may be displayed; representing either Dial-up or GSM/GPRS, and
wireless LAN connections.

Disconnected Windows dial-up or wireless connection. Up to two of these
icons may be displayed; representing GSM/GPRS and wireless LAN
connections.

These icons allow you to edit your Windows Network dial-up connections.
See Making Windows Network Connections Visible on page 16 for
details.

PC Card icon. This indicates that a PC card is present. It allows you to

see certain properties and also to stop / remove the card. See Safe
Removal of the GC79 on page 20 for details.
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lcon Menus

GC79 GSM/GPRS menu

14

Right click one of the following icons to see the GC79 GSM/GPRS menu options.

@  The GC79 GSM/GPRS menu is displayed.

-----

or Open GC79 Manager
Turn G3MJGPRS Radio Off
Mo Conmeckion

IIIII Help

or About GC79 Manager
Hide: b kray:
Exit

il..

or

il

Note:

Some of the these menu options are disabled, depending on the current state of the GC79.
The GC79 GSM/GPRS menu options are described below.

Open GC79 Manager
Select Open GC79 Manager or double click on the GC79 Manager icon to open the GC79
Manager.

Radio Status (Turn GSM/GRPS Radio On/Off)

This menu option is dynamic. It monitors the current state of the GC79 GSM/GPRS radio transmitter
and gives you the option to switch to the opposite state, for example, if your GC79 GSM/GPRS radio
transmitter is on the menu option reads Turn GSM/GPRS Radio Off.

You can also set the status of the GSM/GPRS radio transmitter by selecting Turn GSM/GPRS
Radio On/Off in the GC79 Manager File menu.

Connect/Disconnect
If you are currently disconnected the menu gives you the option to connect to the most recently used
GC79 GSM/GPRS connection. If you are connected the menu gives you the option to disconnect.

Help

Opens the GC79 Manager Online Help. You can also launch the Online Help from the GC79
Manager Help Menu. Pressing F1 in any of the GC79 Manager dialogs opens the relevant
help screen.

About
Displays a dialog that contains GC79 Manager software information.

Hide to Tray

Select the Hide to Tray option to visually close GC79 Manager leaving only the icons visible in
the system tray. Use the Open GC79 Manager option to view the software again.
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Exit

Closes the GC79 Manager application, the GC79 Manager Icon will remain in the system tray if
you have set it to run in the background. See GC79 Manager GSM/GPRS Preferences on page 16
for more details.

GC79 Wireless Control menu
Right click on one of the following icons to see the GC79 Wireless Control menu options.

h The GC79 Wireless Control menu is displayed.

Help 3
or Country 3
E Open Utiliby
Disable Radio
or Hide

Ve

The GC79 Wireless Control menu options are described below.

Help
This menu option provides information about the GC79 Wireless Control Utility.

Country (Where provided)

This menu option allows you to select the operating characteristics that comply with the regulations
that apply in a particular country. Before connecting to a wireless network, you should verify that
the Country value is correct. If you travel to different countries, you must remember to change the
Country as appropriate.

If the destination country is not listed, set the value to Worldwide.
Open Utility
Opens the Wireless Configuration Utility.

See Create a Wireless LAN Connection on page 25 for details.

Radio Status (Enable / Disable Radio)

This menu option is dynamic. It monitors the current state of the GC79 wireless LAN radio
transmitter and gives you the option to switch to the opposite state, for example, if your GC79 Radio
transmitter is on the menu option reads Disable Radio.

You can also set the status of the wireless LAN radio transmitter by selecting Turn Radio On/Off
in the GC79 Manager File menu.

Hide
This menu option allows you to hide the 14 icon from view on the system tray.

Start Using GC79 Manager 15



Making Windows Network Connections Visible

The Windows connection icons, displayed in the system tray, normally disappear once a connection
is made. This means that you may not necessarily see a @l icon corresponding to each of the =
icons for your GSM/GPRS and wireless LAN connections.

To make a @@ icon visible, follow the steps described below.

1. Right click the appropriate %; icon and select Open Network and Dial-up Connections.
Alternatively select Start =+ Settings = Network and Dial-up Connections.

2. A dialog opens displaying all the network connections available on your PC. Right click the one
you want to edit.

3. Click the Show icon in notification area when connected box. Click OK to close the dialog.
When you have an active connection use your mouse to hover over the icon to view connectivity
details.

GC79 Manager GSM/GPRS Preferences

16

You can change the general GSM/GPRS behaviour of the GC79 Manager by selecting specific
options in the Preferences... dialog.

1. Select Preferences... in the File menu. The Preferences dialog opens, the Radio Power
tab is displayed.

x

Fadia Power | Text Messagesl Notificationsl GFRS Eonnectionsl Miscellaneous

Radio Power

™ Enable radio immediately when card inserted.

On application startup and standby-resume: On application shutdown:
& Tum Radio On " Fesst card

© Tum Radio Off & Tum Radio Off
sk Me

QK I Cancel Help
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Radio Power Tab

You can use this tab to manage the state of the radio transmitter.

Enable Radio
immediately when card
inserted

When this option is selected, the GC79 Manager radio power startup and shutdown choices

are disabled.

On

Off

Ask Me

Turn Radio Off

Reset card

You should normally leave this checkbox turned off. When
enabled, the Windows driver turns the radio transmitter on
when the card is inserted and leaves it enabled even when
the card is not in use. You should check this option if your
Windows logon requires you to log on using a dial-up
connection, see Appendix B - Windows Log on using a
GSM/GPRS Dial-up Connection on page 76 for more
details. When you click OK to activate this option the
GC79 Manager displays the following dialog.

GC79 Manager ﬂ
‘fou have selected "Enable Radio immediately when
card inserted"”, This is normally only required to support
‘Windows' Log on using dial-up connection.

Are you sure you wank o do this?

Press F1 for more information.

fes Mo

The radio mode you specify at GC79 Manager start-up
appears selected on the Radio tab.

When the GC79 Manager is running in radio on mode it is
registered to the GSM network and connections can be
made and SMS sent and received. The radio can be
enabled in several ways;

» Select Turn Radio On when the GC79 Manager starts.

» Specify the required radio state in
Preferences Radio Power.

Radio Off indicates that the GC79 will not register

to the mobile GSM network. You may perform non-
communication related activities such as phone book
maintenance, but you must turn on the radio in order
to make a connection or to send/receive SMS.

Triggers a dialog to be displayed every time the PC is
turned on. The dialog asks you if the radio transmitter
should be turned on or off during the active PC session.
This is also called Aeroplane mode, because it prevents
the radio transmitter automatically turning on. This is a
useful feature in areas where radio transmitters are not
allowed; aircrafts, hospitals or blasting areas.

Your GC79 is set to Ask me by default.

At shutdown the radio is turned off.

Turns the radio off and resets the card.

Start Using GC79 Manager
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Text Messaging Tab
You can use this tab to enable reception of specific message classes from the SMS Cell Broadcast
service and to set the SMS received audio alarm to on or off. Select the radio buttons to activate

the options.

Example of SMS Cell Broadcast message types:

Code:
000
010
020
030
040

Cell Broadcast Message
Index

News Flashes

Hospitals

Long-distance road reports
Weather

To enter multiple SMS Cell Broadcast message types separate each entry with a comma,
for example, 000, 034, 076.

Note:

SMS Cell Broadcast message types are network specific. Contact your GSM network operator
for more details.

This screen also allows you to set a validity period for the SMS messages that you are sending.
If your message can not be delivered, for example, if the recipient hasn’t inserted their GC79,
the validity period tells your service centre how long to keep trying to send the message.

Notifications Tab
Click the Notifications tab. You can decide if you want to display a splash screen every time GC79
Manager is opened or closed and a program end confirmation box. Select the radio buttons to activate

the options.

GPRS Connection Tab

18

Establish GPRS connection at startup

Select this option to automatically connect to your chosen GSM network when GC79 Manager
is started. GC79 Manager waits until GPRS is registered and then it establish the specified GPRS
connection. Simply select the name of the connection to be established from the drop down list.
To automatically connect when you start or restart your PC see the example below. If you need
to connect at Windows log on see Appendix B - Windows Log on using a GSM/GPRS Dial-up
Connection on page 76.

Example:

If you want your GC79 to be available and a GPRS internet connection to
be automatically established when you boot your laptop:

- Set Preferences =» Misc =} Run this program when Windows Starts

- Set Preferences = GPRS Connections =+ Establish GPRS Connection
At Startup and select the GPRS connection required.

Re-establish GPRS connection if dropped
If this option is checked, the GC79 Manager will attempt to re-establish the GPRS connection
if it is disconnected due to GSM network problem (poor signal, etc).

Start Using GC79 Manager



Miscellaneous Tab
Click the Miscellaneous tab.
x|

Fiadio Powerl TextMessagesI Notificationsl GPRS Connections  Miscellaneous |

Miscellaneous

[V Hide to tray when minimized

V¥ Run this program when ‘Windows starts
[ Minimize when Windows starts

V' Allaw this prograr to run in the background
[ Hide tray icon when no card inserted

V' Show benu Item for Modem Software Update

QK I Cancel Help

* Hide to tray when minimized
If enabled, when the GC79 Manager is minimized, it removes any window from the taskbar,
and only shows the small icon in the system tray. To re-open the main window, double-click
the tray icon, or select open from the icon menu.

* Run this program when Windows starts
If enabled, the GC79 Manager starts when Windows is started. If a GC79 PC Card is detected,
the GC79 Manager runs. If not, the program closes (and runs in the background if permitted).
When used with Establish GPRS connection at startup, this allows a GPRS session to be
automatically connected when the user logs on, see Appendix B - Windows Log on using a GSM/
GPRS Dial-up Connection on page 76 for more details.

* Minimize when Windows starts
If enabled, the GC79 Manager starts when a user logs on to Windows, it appears as an icon in
the task bar only. If a GC79 PC Card is detected, the GC79 Manager runs and connects. If not,
the program closes (and runs in the background if permitted).

» Allow this program to run in the background
If enabled, the GC79 Manager runs in the background, waiting for a GC79 PC Card to be
inserted. When the card is detected, the GC79 Manager automatically opens and begins normal
operations.
When the close box, or File = Exit is selected, the GC79 Manager closes but does not exit.
It releases control of the card, so it may be stopped and removed, and runs in the background.
You can start the program again from the Start menu, double-clicking the system tray icon,
or by re-inserting the GC79 PC Card.
You can stop GC79 Manager running in the background by right clicking on the PC screen
and selecting Exit.
If you attempt to start GC79 Manager with no GC79 Card inserted a warning dialog is
displayed, informing you that the GC79 PC Card is not present, and GC79 Manager switches
back to background mode.

* Hide tray icon when no card inserted
If this option is selected, GC79 Manager runs in background mode, the GC79 Manager icon
is not displayed in the system tray. If the card is inserted, the icon reappears and the GC79
Manager is started.

Start Using GC79 Manager 19



Show menu item for Modem Software Update

If this option is checked, a File =* Modem Software Update... menu item is enabled.
Selecting this menu command prepares the GC79 PC card to receive a software update from
the Sony Ericsson Update Service. More information about this service can be found at
http://www.SonyEricsson.com/support

Examples: If you want to activate your GC79 when the laptop is booted, so that it is ready
to make a connection and send/receive SMS:
- Set Preferences = Misc = Run this program when Windows Starts.

If you want your GC79 to be available and a GPRS internet connection to be
automatically established when you boot your laptop:

- Set Preferences = Misc = Run this program when Windows Starts.

- Set Preferences = GPRS Connections =+ Establish GPRS Connection
At Startup.

- Select the GPRS connection required.

If you remove the GC79 during usage and want it to be automatically reactivated
when you re-insert it:

- Set Preferences = Misc = Allow this program to run in the background.
Note: If you have Establish GPRS connection at Startup set, then the connection
will also be automatically established when you insert the card.

If you want to start the laptop with the GC79 removed and have it automatically
activated when it is later inserted:

- Set Preferences = Misc = Run this program when Windows Starts.

- Set Preferences = Misc = Allow this program to run in the background.

Class 0 SMS Messages

Class 0 messages contain current information and are replaced frequently, for example, traffic
reports. The GC79 will display any messages that are sent out whilst it is registered on a GSM
network. See Text Messaging Tab on page 18 for further details.

Safe Removal of the GC79
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You must stop the GC79 before attempting to remove it.

1.
2.

Close any active GC79 Networking Connections.
Exit GC79 Manager.

3. Click on the PC Card icon. A list of currently connected PC Cards is displayed. Select Safely

remove Sony Ericsson GC79 Wireless Modem.

A dialog is displayed telling you it is safe to remove the card. Click OK.

5. The GC79 Card can now be removed safely.

Important!
Incorrect removal of the GC79 can damage the card.

Start Using GC79 Manager
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Create a GPRS, HSCSD or CSD Connection

1. Click 2;& or select View = Connection Wizard. The Connection Wizard opens.

2. Select the radio button next to Create a new connection, enter a name, for example
‘My Connection’, click Next.

Note:
Your connection name should not exceed 16 characters for it to be fully visible in
GC79 Manager.

3. The Type of Connection screen opens. From here you select the type of connection
you require:

* For GPRS see steps 4 to 8
*  For CSD/HSCSD see steps 9 to 12

GPRS Connection

4. Select GPRS. Select your Network Operator from the Choose Network drop down list.
If your Network Operator isn’t listed selected <Other>. Click Next.
See GSM Network and Subscription on page 8 for more information on GPRS.

Note:
Type the first letter of the Network Operator you require into the field to list all the operators
that start with that letter.

5. The Access Point Name dialog opens. Your Network Operator’s Access Point Name or Names
(APNs) are displayed, select the APN you want to use. If no APNSs are listed contact your
Network Operator and ask them to supply an APN.

6. To modify the selected APN’s settings, Click Advanced.... See Appendix A - GSM Connection
Parameters on page 74, for descriptions of the updateable parameters in the Advanced dialog.
Click Apply to save any changes before closing the dialog. Click Next.

7. If youhave a logon for your service provider, enter you User ID and Password into the specific
fields. If you don’t need a username and password to connect leave the fields blank. Click Next.

Note:

Some versions of Windows® deliberately change the number of asterisks that represent a
password and place asterisks in the password field when the password is blank in order to
make the display secure.

8. Click Finish to create your connection or Back to review your settings.
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HSCSD or CSD Connection
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9.

10.

11.

13.

Select CSD/HSCSD. Select your service provider from the Choose Network drop down list.
If your service provider isn’t listed selected <Other>. Click Next.

If you selected a Network Operator from the Choose Network drop down list, the telephone
number screen should be automatically filled in.

If you selected <Other> from the Choose Network drop down list; enter the number you need
to dial to connect to your Network Operator in the Telephone Number field; include your
country and area code. Ensure Use Area Code and Country Code is de-selected.

Note:
Contact your Network Operator for a telephone number if necessary.
x|

Telephone Number

Enter the telephone number to dial when making a connection.

If appropriate, select the country code and enter the area code.

Area Code: Telephone number:

Country code:

| i

™ Use area code and country code

Advanced.. |
< Back I [dext > | Cancel | Help |

Click Advanced.... To create a HSCSD connection you must specify your preferred network
connection speed from the drop down list and the method you want to use to connect to the
network, on the Speed tab of the Advanced dialog. Click Next.

Note:

If you are unsure which speed to choose from the Speed tab, start with Analogue 9600, and
check to see if it works. Once your connection works on Analog, you can try the V110/V120
settings to see if faster speeds are available. V110/V120 also connects faster than analog.
When roaming you may need to repeat this procedure to adapt your settings to the capability
of the local network operator.

12.Select the Options tab in the Advanced dialog to specify a

callback number, if required. Callback is a service that allows the

call direction to be reversed. If you want to watch the progress

- of a callback in a terminal window click the Show Terminal
Window After Dialing box.

I Show Teminal Window After Dialing

See Appendix A - GSM Connection Parameters on page 74,
for descriptions of the updateable parameters in the Advanced dialog. Click Apply to save any
changes before closing the dialog.

If you need a User ID and Password to logon to your service provider enter them into the
specific fields. If you don’t need a username and password leave the fields blank. Click Next.
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Note:

Some versions of Windows® deliberately change the number of asterisks that represent a
password and place asterisks in the password field when the password is blank in order to
make the display secure.

14. Click Finish to create your Dial-up or Back to review your settings.

Modify a Connection

. Select Modify a connection. The Select a connection drop down menu is activated.

Click on the menu and select the connection you want to modify.
Click Next.

Change settings as required.

Delete a Connection

1.

2.

Select Delete a connection. The Select a connection drop down menu is activated.
Click on the menu and select the connection you want to delete.

Click Next. The Success screen is displayed. Click Finish to close the Connection Wizard.

Using your Connection

To Connect

1.
2.
3.

Open GC79 Manager.

If requested enter your SIM Card PIN and click OK. The Status screen is displayed.
Select the connection you require from the drop down list and click Connect.

Tip:

To see detailed connection information, including the speed allocated for an HSCSD
connection, select View GC79 Manager Information.

To disconnect an active connection

1.

Click Disconnect on the Status screen.

The GC79 Manager ends the connection.

Alternatively:

Right click on the GC79 Manager icon in the system tray and select Disconnect.

Note:
You can also use the Preferences dialog to set up auto connection when the GC79 Manager
is opened. See GC79 Manager GSM/GPRS Preferences on page 16 for more details.

Create a GPRS, HSCSD or CSD Connection
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Browse the Internet via a GSM/GPRS Connection

You can connect to the Internet using a CSD/HSCSD or GPRS connection:

1. Open your preferred connection from the Status screen. See Using your Connection
above for details on opening a connection.

2. Start your Internet browser. You are online and can browse the Internet.

Send and Receive Emails

You will need an email program installed on your PC in order to send and receive emails.
You can send and receive emails using a CSD/HSCSD or GPRS connection:

1. Open your preferred connection from the Status screen. See Connection on page 36
for details on opening a connection.

2. Start your email program. You are online and can send and receive emails.
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Create a Wireless LAN Connection

To create a connection to a wireless LAN access point, follow the steps described below.

Note:

For details of how to create an ad hoc group connection, see Setting up an Ad Hoc Group
Network on page 30.

1. Before you begin make sure a Wireless LAN access point is in range.

2. Right click [l&d and select Open Utility. The GC79 Wireless Configuration Utility opens.
3. The Wireless Networks tab is displayed.

“ "wireless Configuration Utili |
Site Maonitar | Diagnostics I Infarmation I
Wwireless Networks | Link Status | Statistics

V' Enable Radio

—Awailable networks:
To connect to an available network, click Configure.

g byh etwork Lonfigure

df

Refresh

r— Prefered networks:

Automatically connect to available networks in the order listed

bielanr:
@ i etwaork, Iove up |
Move down |
Add... | Bemave Froperties |

Advanced

()3 Cancel
| I |

|
o
=2
=

Note (XP only):

If the tab doesn’t display available and preferred networks:

Select Start + Settings -+ Network and Dial-up Connections. Right click the Wireless
Network Connection and select Properties. Select the Wireless Networks tab and untick
Use Windows to configure my wireless network settings. Click OK. Repeat steps 1, 2 and
3 above.

Note:

Clicking the Advanced button opens the Advanced dialog, use the dialog to specify the type of
networks you want to access.
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4. Click Add. The Wireless Network Properties screen is displayed.

Wireless Network Properties x|

Metwork name [S510]: ||

—Wwireless network key (WEP)
Thiz netwark requires a key for the following:

[~ Data encryption [WEP enabled)
I~ Metwark Authentication [Shared mode)

Metwork key: I

K.y format: IHexadecimaI digits 'l
Kew length: 104 bits [26 digits] x

K.eyindey [advanced): ID _I;'

¥ The ke is provided for me automatically

™ This is a computer-to-computer (ad hoc) network;
wireless access points are not uged

oK I Cancel |

5. Type the network name in the Network name (SSID) field.

6. Clear the This is a computer-to-computer (ad hoc) network; wireless access points are not
used check box.

7. From here you select the type of connection you require:
* For connection to a LAN that does not require network key information, see steps 8 to 10.

* For connection to a LAN that does require network key information, see steps 11 to 15.

WLAN Connections that do not require Network Key Information

8. If necessary, clear the Data encryption (WEP enabled) box.
9. Click OK. The network name and icon appear at the top of the Preferred networks list.

10. Click Refresh to activate the network connection (wait up to one minute for the network
connection to be made). Your computer is connected to the selected network when you see
a blue bubble on top of the icon for that network.

WLAN Connections that do require Network Key Information

11. Check the Data encryption (WEP enabled) box.
12. Clear the The key is provided for me automatically check box.

13. Type the network key in the Network key field. (You should obtain the key from the network
administrator.).
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Note:

You do not need to select the Key format or the Key length before typing the network key.
These settings automatically change to the appropriate setting as you type the network key
value. However, the key value you enter must be the correct length.

14. Click OK. The network name and icon appear at the top of the Preferred networks list.
15. Click Refresh to activate the network connection (wait up to one minute for the network

connection to be made). Your computer is connected to the selected network when you see 'i:'
next to the network name.

Using a Connection

If your GC79-enabled computer is running at a location in which a wireless LAN is operating,
and it is within range of the access point, the computer automatically connects to the network
which is highest on the Preferred networks list on the Wireless Configuration Utility screen
Wireless Networks tab. You can change the order in which networks appear in this list by using
the Move up and Move down buttons.

Alternatively, if you have more than one network access profiles defined, you can specify the
connection you want to use by clicking [l . The Connect to Wireless Network screen is displayed.

Connect to Wireless Network

The following network[z] are avalable. To access a network, select
it from the list, and then click Connect.

Available networks:

Fu [ yh etwork

Thiz network requires the use of a network key (WEP). To access
this network, type the key, and then click Connect.

Metwork key: |

If you are having difficulty connecting to a netwark, click Advanced.

Advanced...l Lonnect I Cancel |

The list shows all the connections you have defined which are within range of an access point.
Highlight the one you want to use, enter a Network Key (if appropriate) and then click on Connect.

Note:

If you are using Windows XP some of the processes explained in this manual interact with
the operating system differently, see your Windows XP help for more details.

Once you have established a WLAN connection on an XP machine, Windows takes over,
you will either have to use the standard Windows WLAN application to monitor your
connection or specify that you want to use GC79 WLAN utility.
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Viewing the Status of your Wireless Connection

28

The quality of the connection (signal strength and noise) of the particular network you are connected
to is indicated by the horizontal bars and the decibel level values that are displayed at the bottom of
the Link Status tab in the Wireless Configuration Utility.

[ “wireless Configuration UE x|
Site Monitar | Infarmation I
wireless Metworks : Statistics
r~ Connection
SEAIS. oo Azsociated
Metwork Mame [SS1D].............. Myl etwork
AP's MAC Address............o.. 00:09:58:67.76:C9
WEP........ ... Enabled
Speed.. 11.0Mbps
Charnel..... 1
Client |P Address........ ... 192.168.0.2M
Metwork Connection Type........ Infrastructure
~ Signal
Fiadio State.............. Enabled
signa: [HERRNERRRE 52 dBm
Noize: (N -83 dBm
ak I Cancel | Lpply |

The signal strength is also indicated by the appearance of the B icon in the system tray.
The description of the signal strength appears when you hover the cursor over the icon.

The table below shows the signal strength and suggested action for improving the signal for each
icon image that may be displayed. If the signal strength indications are anything other than very
good or excellent, you should take the appropriate suggested action.

A fully green icon indicates that the signal strength is very good
or excellent

A partially green icon indicates that the signal is good or low.

Suggested action: Move closer to the access point.
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1 A grey icon indicates that there is no signal being received.
Probable causes:

The computer is trying to establish an initial connection but has
not yet succeeded.

You may have moved out of range of the access point.
Suggested action:
Wait.
Move closer to the access point.
E An icon with a red bar indicates that there is no radio connection.

Suggested action: Enable the WLAN radio by right-clicking the
icon and then selecting Enable Radio.

Disabling the Radio

To disable the GC79 wireless LAN radio, right click #4 and select Disable Radio. To enable the
radio, right click ¥ and select Enable Radio.

Alternatively, use the Disable/Enable button on the right hand side of the GC79 Manager Status
screen or the option in the File menu.

Modify a Wireless Connection
1. Open the Wireless Configuration Ultility, as described in Create a Wireless LAN Connection on

page 25, and click on the Wireless Networks tab.

2. Select the network connection from the Available networks list and then click on Configure.

Wireless Network Properties 1'

Metwork name [SSID]: bkl etwork

—wireless network key MWEF)
This network requires a key for the following:

¥ Data encryption [WEP enabled)
I Metwark Authentication [Shared mode)

Metwork key: I

K.ey format: W
Key length: lm
Key index [advanced): IG

¥ The keyis provided far me automatically

™ This is a computer-to-computer (ad hos) network:
wirgless access points are not used

oK I Cancel |

You can enable or disable data encryption and change the network name and the network key.
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Advanced Wireless LAN Features

Setting up an Ad Hoc Group Network

30

In ad-hoc mode, a peer-to-peer network is created. An example might be networking laptops in

a meeting room in order to share information. The network is set up at the start of the meeting and
disappears when the last laptop is shut down. The following instruction explain how to set up an ad
hoc network using two PCs, however you can network any number of PCs together, just make sure
they have a unique IP number.

1. On laptop 1, select Start = Settings = Control panel = Network connections, right click
on Sony Ericsson 802.11b adaptor and select Properties.

2. The Wireless Network Connection Properties Window opens, in the General tab select Internet
Protocol (TCP/IP) and click Properties.

3. The Internet Protocol (TCP/IP) Properties dialog opens. Click Use the following IP address:.
Type a unique IP address into the field, for example, 192.168.0.1

The subnet mask should be generated automatically, if it isn’t use 255.255.255.0
Make sure the Use windows to configure my wireless network settings isn’t selected.
Click OK.

N s

On laptop 2, select Start = Settings =)+ Control panel =)+ Network connections, right click
your Wireless Network Connection and select Properties.

8. The Wireless Network Connection Properties Window opens, in the General tab select Internet
Protocol (TCP/IP) and click Properties.

9. The Internet Protocol (TCP/IP) Properties dialog opens. Click Use the following IP address:.
Type a unique IP address, for example, 192.168.0.2

Note:
IP address must be unique for each machine.

10. The subnet mask should be generated automatically, if it isn’t use 255.255.255.0

11. Make sure the Use windows to configure my wireless network settings isn’t selected.
12. Click OK.

Note:

If the laptop is going to be connected to the company network again, you must remember it
change the Use the following IP address: back to Obtain an IP-address automatically in both
laptops.

Perform steps 11 to 16 on both laptops.

13.Right click l& and select Open Utility. The Sony Ericsson Wireless Configuration Utility
opens. The Wireless Networks tab lists all the available networks. If your new adhoc network

isn’t listed click Add, make sure you enter a name for the adhoc network in the Network name
(SSID) field.

14. Complete the necessary fields and activate the This is a computer-to-computer (ad hoc)
network; wireless access points are not used box. Click OK.
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15. Click Advanced select the appropriate radio button to specify the Networks the GC79 can
access. You can select either; Computer to computer (ad hoc) networks only or Any
available network (access point preferred).

Networks to access

(O Any available network (access point prefemed)

() Access point (infrastructurs) networks only

(%) Computerto-computer (ad hoc) networks only

[] Automatically connect to non-prefemed networks

Close

Note:
Once you create an AdHoc Wireless Network it will appear as available even if this is the only
laptop on the network.

16. Restart all the laptops that are part of the ad hoc network to allow the new IP address settings to
be approved.

17. Open GC79 Manager on all the laptops. Make sure the WLAN connection is enabled. If WLAN
icon in the system tray doesn't turn green right click g and check the radio is on (menu will
display Disable radio).

Note:
Make sure that Firewall on the computers is setup to allow this type of connection or disabled.
Ask your Network Administrator if you need assistance.

18.Right click I and select Open utility. Select the Site Monitor tab, tick the Ad hoc network
only box. The Network Name (SSID) you specified should appear after a short delay. Click OK.

Connecting the PCs

1. Select one of the laptops, right click My Computer and select Map Network Drive. In the
dropdown list select a free hardriver name that is not occupied by any other name.

2. Type \\laptop name or IP address\C$ into the Folder field. In this example we would enter

\\192.168.0.1\C$ to connect to the 1st laptop we set up.C$ is specifying the drive on the laptop
that you want to connect to.

Note:
To find a computers name; open a Command Prompt on the PC you want to find the name of.
Type hostname and press return. The computer name is returned.

Note:

You can also use a Command Prompt to make sure you can see the other PC. Type ping
<IP address> and press return (The IP address belongs to the PC you are trying to contact).
In the example we would enter ping 192.168.0.1, PC 1 sends a small amount of data to PC2,
if the PC is contacted replies for each packet of data sent are returned.

3. Ifyouare required to log on to the PC before access is granted select Connect using a different
user name. Make sure you have an alias and password set-up on the PC you are connecting to.

4. Enter your User name and Password into the Connect As... dialog.
5. Click OK and Finish.
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After a while a new window should popup in PC2 showing the hardrive of PC1. It is also listed with
your Network Drives.

Tip:
See your Windows documentation for further details on setting up a network of Windows PCs.

ICaution:
Unwanted users may try to connect to your ad hoc network. Use of security features such as
WEP is recommended.

Disable the WLAN

1. Right click l& and select Disable radio.

Sharing an Internet Connection

To connect a group of computers using a shared Internet connection, select one of the desktop
computers to serve as the host computer (all other computers are called clients).

The host computer is the only computer that connects directly to the Internet. It is recommended that
the desktop computer having the fastest microprocessor and the most memory is used as the host
computer.

The host computer must be running either the Windows 2000 or Windows XP operating system.

Connection sharing requires that the host computer has either a modem or another network adapter
in addition to the GC79. The modem or the additional network adapter is used to access the internet.
The GC79 is used to share the connections with other clients.

Setting up Internet Connection Sharing (ICS) on the Host Computer

32

1. Connect the host computer to the internet.
. Click the Start button.

2
3. Select Settings = Control Panel.

4. Double-click Network and Dial-up Connections.
5

. If the host computer is connected to the internet using a dial-up connection, double-click Dial-

up Connection = Properties = Sharing, and then ensure that both Enable Internet
Connection Sharing for this connection and Enabled on-demand dialing are selected.

If the host computer is connected to the internet using a cable or DSL modem, double-click

Local Area Connection =j» Properties = Sharing, and then ensure that the Enable Internet
Connection Sharing for this connection option is selected.

Note:

For Windows 2000, you must enable local network sharing and select the Local Area
Connection relating to the Sony Ericsson 802.11b adaptor. You can check this by looking at
the Device Name in the Network and Dial-Up Connections list. If your Sony Ericsson 802.11b
adaptor is listed as Local Area Connection 3, then select Local Area Connection 3 in the
'For local Network' drop-down box.

For Windows XP, follow the Bridging instructions below.
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Bridge connections on Windows XP

The network bridge allows you to connect network segments by selecting the appropriate network
connection and bridging them together. The network bridge manages your network segments,

and creates a single IP subnet for the entire network. There is no configuration required, and you do
not need purchase additional hardware such as routers or bridges. IP addressing, address allocation,
and name resolution is highly simplified in a single subnet IP network.

Only one bridge may exist on a Windows XP computer, but it can be used to bridge as many different
network connections as the computer can physically accommodate.

Before you begin make sure you are logged on to the computer as an administrator.

1. Select Start Control Panel, and then double-click Network Connections.

2. Under LAN or High-Speed Internet select each of the private network connections that you
want to be part of the bridge.
You must select at least two eligible network connections in order for Bridge Connections to
create a bridge.

3. Right click one of the highlighted private network connections, and select Bridge Connections.
You can create only one network bridge on a computer, but the bridge can accommodate any
number of network connections.

ICaution:
Do not use this method to share a corporate network connection without first agreeing security
procedures with the network administrator.

Note:

» Adapters that have Internet Connection Sharing (ICS) or Internet Connection Firewall (ICF)
enabled cannot be part of the network bridge and will not appear on the Network Bridge
checklist. Similarly, the Add to Bridge menu command is available only for adapters that you
can add as connections to Network Bridge.

* Only Ethernet, IEEE-1394 adapters, or Ethernet compatible adapters such as wireless and home
phoneline adapters (HPNA), can be part of the network bridge.

» Do not create a bridge between the public Internet connection and the private network
connection, or add the public Internet connection to an existing network bridge, if you do not
have ICF or Internet Connection Sharing (ICS) enabled. To do so will create an unprotected link
between your network and the Internet, and your network will be vulnerable to intrusions.

* Ifyou remove adapters from the network bridge, and less than two adapters remain, Network
Bridge will not perform its intended function, but it will continue to use system resources.

» Network adapters that previously appeared under LAN or High-Speed Internet, appear under
Network Bridge when they are added as connections. Network adapters that provide Internet
connectivity, such as DSL and cable modems, cannot be bridged and will always appear under
LAN or High-Speed Internet.

* Network bridges with wireless or IEEE-1394 connections support traffic using Internet Protocol
version 4 (IPv4) only.

4. Internet Connection Sharing, Internet Connection Firewall, Discovery and Control, and
Network Bridge are not available on Windows XP 64-Bit Edition.

ICaution:

When sharing an internet connection, unwanted users within the reach of the wireless LAN
may be able to use it too. It is recommended that you use of security features such as WEP
network keys.

Creating profiles for ICS Client machines

Set up an ad hoc network on your host machine and each client. Follow the Create a Wireless LAN
Connection on page 25.
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Wireless LAN Adapter Diagnostics

You can run a number of diagnostics on your GC79 wireless LAN adapter to verify its operational

and functional status.

Note:
Your network connection is lost when you run the diagnostics. When the test run is over,

your network connection is automatically re-established.

Open the Wireless Configuration Utility, as described in Create a Wireless LAN Connection on
page 25, and click on the Diagnostics tab.

x|

wireless Metworks | Link Status | Statistics I
Diagnostics | Infarmation

 nyireless Configuration U ¥

Site Monitor

Tests | Results |

Contral Registers

SPROM Format W alidation
Memory Tests

Intempt Test

Loopback Test

Seiectall | cleara sop | TR

— Recommendation

[
ok I Cancel | Apply |

2. Select the tests you want to run. All tests are selected by default. To run an individual test or
some but not all of the tests, clear the check box for those tests that you do not want to run.

3. Click Run.

GC79 WLAN Information

You can view detailed technical information about your GC79 WLAN connection by selecting the
Information tab in the Sony Ericsson Wireless Configuration Utility. Your MAC number is list on

this screen.
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GC79 Manager Status Screen

The Status Screen is displayed when GC79 Manager opens. You can also open the Status screen

by clicking E or selecting View = Status.
Menu Bar | GCTO Manager - Status =10 x|
File Edit Yiew Phonebook Messages Help
Screen lcons =1 || 7 ﬁ}/}) @ g k{ @
P
d BRX PAEE P EE®S
GSMIGPRS
Avallable — —G5M/GPRS — 80211 WlAaN
Signal Iliii
Strength LA
MyNetwork — |
Metwork = Connected
Operator
1~ My O perator -
Current / -l—/
Status Diuratior: 00:00:18

Sent: 4707 Bytes
Feceived: 1244 Extes

Encryption
Enabled

Connected

/" lcon

Wireless LAN
MNetwork

Current
Status

\\\ Disable/

Enable

\
\ \ i i

For Help, press F1 / !

[

\ \

SMS Full Mew SMS Connected Wireless
lcon Received leon LAN Signal
Strength

The Status screen shows information about your GSM and wireless LAN network connections.

The body of the screen is divided into two.

GSM Connection Status

The left side of the screen shows information about your GSM connection, including icons

representing:
» Receive signal strength

* GPRS service status

*  Unread SMS Text Message [ status (or SIM Full indication [B=]). See GC79 Manager

SMS Messages Screen on page 48 for more details.
» Connection status
The left side of the screen also displays:
* The current Network Status, e.g. searching, radio off

» The connection progress messages

GC79 Manager Status Screen
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Connection

When a connection is established, the connection statistics (duration, bytes transmitted, bytes
received) are displayed and updated at regular intervals.

Note:

Statistics display is not supported on Window 98(SE) or Me platforms. To view statistic data
when using these operating systems hover your mouse cursor over the standard Windows
Dial-up Networking icon.

To connect, cancel or disconnect a GPRS or HSCSD/CSD data session
use the Connect/Disconnect drop down menu. The menu displays all the
connections you have defined, so you can quickly select the required
connection.

My GPRS Connection j
- Select a connection -

|GPR

5 Connections
TNEIw

{5 L onne chion

. HSCSD C i
The Control button, located underneath the drop down menu, changes its | Hstsp Cornection

appearance depending on the state of the GC79 connection. The button
allows you to:

* Initiate a connection (Connect)
» Cancel connection attempt (Cancel)
* Disconnect (Hang-up) an existing session
To create a connection see Create a GPRS, HSCSD or CSD Connection on page 21.
Note:
You can also launch or terminate a CSD dialup networking sessions directly from the Windows
Network Connections icon. A HSCSD networking session initiated outside GC79 Manager will

require some additional settings to be added to your init string, see Appendix D- Initiating a
HSCSD Connection from Outside the GC79 Manager on page 79.

Wireless LAN Connection Status
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The right side of the Status screen shows information about your wireless LAN connection,
including:

*  Wireless LAN connection status
* Connection speed
» Signal strength
* Network name (SSID)
The Disable/Enable button allows you to switch the wireless LAN radio on and off.
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GC79 Manager Telephony Settings Screen

The Telephony Settings screen allows you view and change the GSM and wireless LAN settings
of the GC79.

The functions of the Telephony Settings screen are very similar to the settings that you have access
to via a mobile phone’s display. A Wireless 802.11 option provides access to the Sony Ericsson
Wireless Configuration Ultility.

Note:
Your GC79 has to be connected to your computer to make changes to the settings.

1. Click & or select View =} Telephony Settings.

1< GC79 Manager - Telephony Settings - SMS Service Centre . =] ]

File= Edit “ew Phonebook Messages Help

S L B R

dERY(MEGFES%S

Phone Numbers

| o Mylunbers SMS service centre
Locks
# Phone Lock
# Sih Lock
Set active service centre number bo:
Metworks

# Cument Metwark.
+ Prefered Metworks
+ Frequency Band

Divert Calls

* A Define a Service centre number where outgoing messages are sent. If you
*"Yoice have alist of service centre numbers in your phone, the active number i
* Fax updated.

* Data

Restrict Calls

* Fax
# Data
Wireless
+ 80211
Apply
For Help, press F1 VR

The window is divided into two areas: the navigation area on the left and the information area
on the right.

When you have selected a setting in the navigation area, GC79 Manager retrieves the current
setting information from the GC79 and displays the information in the right area.
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Phone Numbers

My numbers

You can list all your own numbers here. The numbers are for personal reference only and have
no operational effect on the GC79.

Voice line 1 and 2:
The voice number or numbers issued with your SIM card that you use for normal voice calls.
If you have line 2 (alternate line service) enter in the Voice Line 2 number field.

Data:
The number used to make a data call to the GC79 (Mobile Terminated).

Fax:
The number used to send a fax to the GC79.

Click Apply when you have finished, to transfer the changes back to your GC79. This may take
a few seconds.

SMS Service Centre

Locks

Phone lock

38

When you send a text message it goes to your operator's service centre, they then forward it to
the correct recipient. The SMS service centre is identified by a telephone number.

Note:

The SMS Service Centre number is normally read automatically from your SIM card.
To Set or change the service centre address:
1. Enter your operator's service centre phone number in the Number text box.

2. Click Apply to transfer the setting to your GC79.

The phone lock protects the GC79 against unauthorized use if it is stolen and used with another
SIM card. Phone Lock is not activated when you buy the GC79.

You can use this screen to change the default security code (0000) to any four to eight digit
personalized code.

You can set the Phone Lock Status to one of the following states:

* On - A brief message Phone locked is displayed each time you turn on the computer.
The Enter the phone lock code dialog opens. Enter your code into the dialog and click OK.

e Off - The GC79 is not locked.

* Automatic - If the Automatic setting is selected, the message Phone locked only appears
when a different SIM card is inserted into the GC79. After the security code has been entered
correctly, the GC79 can be used with the new SIM card.

Note:
The Phone Lock code has four to eight digits and is shown as asterisks upon entry
in the dialog.
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To Change the Phone Lock code:
1. Click Change Phone Code
2. The Change the Phone Lock Code dialog opens. Make the required changes and click OK.

3. Click Apply when you have finished, to transfer the changes back to your GC79. This may take
a few seconds.

SIM lock
Some SIM cards are protected with a PIN (Personal Identity Number) at the time of purchase.
If the SIM card lock is activated, you have to enter the PIN every time you turn on your PC and open
GC79 Manager. If you enter your PIN incorrectly three times in succession, the SIM card is blocked
and you need a PUK code, from your network operator, to unblock the SIM card.
» To activate the SIM card lock, select the On radio button.
Caution!
Only activate the SIM card lock if you know the PIN code.
» To cancel the SIM card lock, select the Off radio button.
Note:
You have to use your PIN code to turn the SIM card lock off.
To Change the PIN Code:
1. Click Change Pin Code...
2. Enter your old PIN code, followed by your new four to eight digit PIN code. Confirm the new
code by entering it again.
3. Click OK.
Note:
The SIM card lock only protects your subscription and not your GC79 from unauthorized use.
If you change your SIM card, the GC79 will still work with a new SIM card.
4. Click Apply when you have finished to transfer the changes back to your GC79. This may take
a few seconds.
Networks

Current Network

You can select which network you want to use by going to Networks and then choosing Current
Network.

Searching for the available networks:

* Click Retrieve, the current network appears in the box with all the other currently available
networks.

The available networks will fall into one of the following three categories:
» The home network, the one with which you have subscription.

* Available networks, networks that your home mobile operator has a roaming agreement with.
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* Forbidden networks, you can’t use these networks except for emergency calls. If your home
network and a forbidden network come to an agreement that allows you to use the forbidden
network, you can select this network even though it is forbidden.

Choosing another network:
1. Uncheck the Automatically choose a network for me.

2. Select the network that you want to use.
3. Click Apply to transfer the setting to your GC79.
The message Please wait appears briefly on the screen. If you are not allowed to use the network that

you have chosen, Forbidden is displayed.

Note:

HSCSD is not available in every GSM network and requires a supplementary roaming
agreement between mobile operators for visiting users to use HSCSD. Check with your home
operator regarding the country or region in which you want to roam.

GPRS is commonly available in GSM networks, but fewer roaming agreements are in place.
You may therefore need to explicitly select one of the available networks in order to use GPRS
when abroad. Check with your home operator to find out which networks are GPRS roaming
partners in the country or region in which you want to roam.

Preferred (network)

A list of preferred networks is stored on the SIM card. This is typically set up by your mobile
operator as part of SIM manufacture. Preferred roaming partners are placed in the list so that you
have the greatest range of available services whilst roaming. When the home network is not
available, the GC79 will check the available networks against the preferred network list and select
the one placed highest. Automatic network selection must be enabled.

If you want to add a new network:

1. Click Add, a new dialog with all the networks known to the GC79 appears on the screen.
2. Select the network that you want to add and click OK.

3. Click Apply to transfer the setting to your GC79 SIM card.
If you want to delete a network from the list:

1. Select the network that you want to delete.

2. Click Remove.

3. Click Apply to transfer the setting to your GC79 SIM card.
If you want to re-arrange the order of the networks listed:

1. Select the network that you want to move.

2. Click the Up or Down arrows to rearrange the order.

3. Click Apply to transfer the setting to your GC79 SIM card.

Note:
If the list of preferred networks is full, the Add button is disabled (grey).
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Frequency Band

Divert Calls

All

Voice

GSM operates in a number of different frequency bands. 900 and 1800 MHz are used in Europe,
Asia, Australasia and Africa, whilst the 1900 MHz band is used in North and South America.

By default your GC79 operates in 'tri-band' mode and automatically finds available networks in any
of these frequency bands. It is not recommended to change this setting. See GSM Performance and
technical characteristics on page 64 for a list of GSM frequency ranges.

Note:

The GC79 does not make or answer voice calls. The divert function enables you to send a
voice call to an alternative number where it can be answered. For example, the mobile network
voicemail service. However you can make and answer fax and data calls, providing you have
appropriate software on your PC to handle them.

If you want to make certain that all your incoming calls are taken care of when you cannot answer
them, you can use the Call divert service to divert them to another number that can handle the types
of calls you expect to receive.

Note:
The Call divert service may not be available on all networks.

Selecting a call divert setting:
1. To obtain your current call divert settings from the network, click Retrieve.

2. Make your changes by identifying when you want to divert your incoming calls. You can select
from four different diversion options:

— Always: this diverts all incoming calls to the phone number that you have entered in the
text box

—  When busy: for example, on CSD calls
— No reply

— Not reachable: for example, when your phone is turned off

3. If you know which number to divert your calls to, then type the number in the text box next
to the divert option you have chosen.
Or

Click .. | to choose a phone number from your phone book.
4. Click Apply, to transfer your new settings to your GC79. This may take a few seconds.

Your call divert setting has now been stored in the network.

You can use the Call divert service to divert your voice calls to another phone number.

Note:
The Call divert service may not be available on all networks.
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Fax

Data
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Selecting a call divert setting:
1. To obtain your current call divert settings from the network, click Retrieve.

2. Make your changes and select in which situation you want to divert your incoming calls.
You can select from four different diversion options:

— Always: this diverts all incoming calls to the phone number that you have entered in the
text box

—  When busy
— No reply

— Not reachable: for example, when your phone is turned off

3. If you know which phone number to divert your calls to, type the number in the text box next
to the divert option you have chosen.
Or

Click .| to choose a phone number from your phone book.
4. Click Apply to transfer them to your GC79. This may take a few seconds.

Your Line 1 divert setting has now been stored in the network.

If you want to route your incoming fax calls to another number, you can use the Call divert service.

Note:
The Call divert service may not be available on all networks. Also, if you are using the Call
restricting function, this may influence Call divert.

Selecting a fax divert setting:
1. To obtain your current fax divert settings from the network, click Retrieve.

2. Select Always if you want to divert all the incoming calls to a specific phone number.

3. If you know which phone number to divert your calls to, type the number in the text box next
to Always.
Or

Click .. | to choose a phone number from your phone book.
4. Click Apply to transfer your settings to your GC79. This may take a few seconds.

Your fax divert setting has now been stored in the network.

If you want to route your incoming data calls to another number, you can use the Call divert service.

Note:
The Call divert service may not be available on all networks. Also, if you are using the
Call restricting function, this may influence Call divert.
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Restrict Calls

Selecting a data divert setting:

I.
2.

3.

4.

To obtain your current data divert settings from the network, click Retrieve.

Select Always if you want to divert all the incoming calls to a specific phone number.

Select the Always check box and enter the destination number or click - | to choose a phone
number from your phone book. Click OK.

Click Apply to transfer your settings to your GC79. This may take a few seconds.

Your data divert setting has now been stored in the network.

Restricting a certain type of call means that this type of call cannot be made to or from your GC79.
You can restrict different types of outgoing and incoming calls.

The following call types can be restricted:

all outgoing calls.

all outgoing international calls.

all outgoing international calls except to your own country.
all incoming calls.

all incoming calls when you are abroad (when roaming).

A password, issued with your subscription, is required to turn a call restrict on or off. Contact your
network operator for further information.

Restricting Fax and Data Calls
To Change the call restrict status for fax and data calls:

Wireless

802.11

1.
2.

3.
4.

To get your current call restrict settings from the network, click Retrieve.

Tick the boxes next to the call types that you want to restrict.
Only select one outgoing and one incoming option.

When you have finished, click Apply.
Type your restriction password into the dialog and click OK.

Your call restrict settings have now been changed and stored in the network.

To configure, monitor and control your GC79 wireless LAN connections, click on the Launch
Wireless Control Panel button.

The Wireless Configuration Utility is displayed. See Create a Wireless LAN Connection on page 25
for details.
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GC79 Manager Phone Book Screen

The GC79 Manager Phone Book screen helps you to organize your GC79’s SIM Phone Book.

The Phone Book Screen

A SIM Phone Book can easily become disorganised; you can use the Phone Book screen to manage
your SIM Phone Book entries.

You can add new numbers, edit existing numbers and export and import entries.

1. Click to display the Phone Book screen.

|.&' GC79 Manager - Phone Book - (44,/150) SIM Phonek 10l =|
File Edit Yiew Phonebook Messages Help
S £ @ R
R E N
Mame | Fhone Mumber | -
Brown 079876541230
Johnson 079876541231 |
Jones 077886541437
Fhillips 074563511233
Saved
Phonebook
[
For Help, press F1 l_ QYR

2. Icons appear in the left pane representing the SIM Phone Book and Saved Phone Book
. You can manage your Phone Book entries by copying entries to the SIM Phone Book
or the Saved Phone Book.

3. Click on the icon to display the Phone Book entries in the right pane.

Note:
Your GC79 must be inserted to display this information.
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Phone Book Functionality

To Add a Number:
1. Select Add new in the Phone Book menu or click on the toolbar or key Ctrl and N.
2. The New Phone Book Entry dialog opens.

New Phone Book Entry =

Mame ||

Phone Mumber I

)8 | Cancel |

3. Enter the name and phone number.
4. Click OK to save the entry or Cancel to close the dialog.
Note:

Phone Book numbers are limited to 20 digits (including +) and names are limited to
18 alphanumeric characters.

New entries are added to the next available SIM index position.

To Modify a number:
1. Select the number you want to modify.

Select Modify... in the Phone Book menu.
The Edit Phone Book Entry dialog opens.
The fields in the dialog display the current entry’s name and number.

Edit the information.

A

Click Save to close the dialog and save your changes.
If the modified entry is in the SIM Phone Book the changes are automatically sent to the SIM.

To Find Entries:
1. Select Find in the Phone Book menu or key Ctrl and F.

2. The Find dialog opens. Enter the text or number you want to search for in the Look for field.
The entry can be complete or incomplete.

3. Click Find. The GC79 Manager searches both Phone Books, when a match is found it is
displayed in the right pane. Click Find Next to search again.

4. Click Close when you have finished searching.

To Copy an Entry:
1. Select an entry from the SIM Phone Book or the Saved Phone Book.

2. Select Copy To in the Phone Book menu. The Copy To option is followed by the name
of the Phone Book you haven’t selected the entry from.

3. A duplicate entry is made in the specified Phone Book. The new entry is assigned the next
available position in the destination Phone Book.
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To Move an Entry:
1.

2.

Select an entry.
Select Move To in the Phone Book menu. The Move To option is followed by the name of the

Phone Book you haven’t selected the entry from.

3. The entry is moved from its current Phone Book and placed in the selected one. The new entry
is assigned the next available position in the destination Phone Book.

To Import an Entry or Phone Book:
1. Select Import from the Phone Book menu.

Import Phone Book =

Import O ption

' Replace Existing Phone Book
" Merge ‘With Esisting Phone Book

Import File Mame:

[mpart | Cloze |

2. Select the Replace Existing Phone Book or Merge with existing Phone Book radio button.
3. Click - and browse to find the file you want to import.

Note:
The file must be a text file in comma separated value (CSV) format. Any invalid lines
or files will be ignored.

4. Click OK in the browse dialog. The path and file name are displayed in the Import File

Name field.
5. Click Import to complete the import procedure.

To Export an Entry or Phone Book:
1. Highlight the entries or open the Phone Book you want to export.

2. Select Export from the Phone Book menu.

x
Items To Export
’7 s Al " Selected ltems

Export File Mame:
| |

Cloze |

Export |

3. Select All to export the entire Phone Book or Selected Items to export the highlighted entries.
4. Type a name for the file into the Export File Name field.

5. Click | and identify the save location.
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Note:
The file will be saved as a text file in comma separated value (CSV) format.

6. Click OK in the browse dialog. The path and file name are displayed in the Export File
Name field.

7. Click Export to complete the procedure.

Delete a number
1. Select the number that you want to delete.

2. Select Delete, from the Edit menu.

3. A confirmation dialog opens, click Yes to delete the number.

Note:

If you want to delete all numbers, select Select All from the Edit menu before clicking Delete.

To Send a New SMS Message:
1. Select an entry from a Phone Book.

2. Select Create New Message from the Messages menu.

3. A new SMS Message dialog is opened and pre-addressed with the selected entries details.
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GC79 Manager SMS Messages Screen
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The GC79 Manager’s SMS Messages screen enables you to view, compose, edit, save, copy, delete,
reply or forward SMS messages from your GC79 to other mobile devices.

Note:
To use Message functionality SMS must be included in your subscription, contact your network
operator for more details.

|.&' GC79 Manager - 5MS Messages - S5IM 5MS (1,/35%) 10l =|
File Edit Yiew Phonebook Messages Help
R
& Bz 2 X | M R Y | P W R
Statuz | Meszage | Fram | Date |
= Hella Jones Sun B/8/2003 ...
Q Delivery Status  Brown wed B/4/2003 ...
Meszages
Sent ltems
From
g Text
Unsent ltems
For Help, press F1 QYR

The SMS Messages screen is split in to a left and right area.
The left area displays the folders; SIM SMS, Saved Messages, Sent Items and Unsent Items.

The right area displays the contents of the selected folder. The top half of the right pane displays
a list of received messages, sorted by date and the bottom half of the screen displays the content
of a selected messages, this is referred to as the Information View.

The folders and their names are static, you can not change them.

. Click to display the contents of the SIM Inbox. When GC79 Manager is opened
any new SMS in the SIM Inbox are uploaded to the PC automatically.
A status flag indicates whether a message is read or unread.
If a new SMS arrives when the GC79 Manager is open @ is displayed on the
Status screen and the SMS audio sound is played, if enabled in the Settings
dialog. See GC79 Manager GSM/GPRS Preferences on page 16.

lgl If you want to keep an SMS, use the copy or move menu options to place it in the
Saved folder. Click on the folder icon to display the contents of the Saved folder.

A copy of each SMS that you have sent is stored in this folder. Click on the folder
icon to display them.

Any composed messages that have not been sent are displayed when you click
on this icon.

SMS stored in this folder can be edited or sent when the GC79 is connected.
Any SMS that fail during transmission are also stored here, you can resend them
at any time.

% Dé
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Each time the SMS Messages screen receives a new SMS message from the SIM it checks the status
of the SIM Inbox. If the SIM Inbox is full, a SIM Full icon is displayed in the left pane of the screen,
see SIM Inbox is Full: on page 51.

Note:

For all the SMS Messages screen menu options to operate the GC79 must be registered
successfully on a network. You must have a GSM signal to Send SMS, the button is disabled
(grey) if you don’t have a signal.

Class 0 messages

If you receive a Class 0 message, it will appear in a pop-up dialog, which you can save or dismiss.
If you choose to save the message it will be stored in you Saved Messages folder.

SMS Manager Functionality

To Send an SMS:
1.

2.
3.

Select Create New Message... from the Messages menu or click B .
The New Message dialog opens.

Enter the recipient’s mobile phone number in the To: field or select a number from a phone
book by clicking Lookup....

To send an SMS to multiple numbers, hold down Ctrl when selecting the numbers from the
phone book.

Type your message into the Message: field.

5. Ifrequired you can click the Calculate SMS blocks to see how many SMSs your message will

6.

be split into. Also you can check the Request Status Report to get confirmation when the SMS
arrives at its destination (if this service is supported by your network).

Click Send to send the SMS or Cancel to close the dialog without sending the SMS.

To Edit a Message:
When you are working with a message, you can edit the text by cutting, copying and pasting.

Moving Text:

1.
2.
3.

Select the text you want to move, the text can be in another PC application.

Select Cut from the Edit menu or Ctrl and X on the keyboard.

Place the cursor where you want to insert the text and select Paste from the Edit menu
or Ctrl and V on the keyboard.

Note:
If you want to copy text, select Copy (Ctrl and C) from the Edit menu instead of Cut
(Ctrl and X).
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Reply to an SMS:
1.

2.

Select the folder where the message is located.

From the list, select the message you want to reply to. The contents of the message are displayed
in the information view.

Select Reply in the Messages menu. A dialogue appears. The To: field is automatically filled
in and the original message is displayed in the Message: field.

If required you can click the Calculate SMS blocks to see how many SMSs your message will
be split into. Also you can check the Request Status Report to get confirmation when the SMS
arrives at its destination.

Type your reply and click Send.

To Forward an SMS:

1.
2.

Select the folder where the message is located.

From the list, select the message you want to forward. The contents of the message
are displayed in the information view.

3. Click Forward, a dialogue opens.

Delete an SMS:
1.

2.

Enter the phone number in the To: field or click Lookup... to select a number from a phone
book.

To send an SMS to multiple numbers, hold down Ctrl when selecting the numbers from the
phone book.

If required you can click the Calculate SMS blocks to see how many SMSs your message will
be split into. Also you can check the Request Status Report to get confirmation when the SMS
arrives at its destination.

Click Send.

Select the folder where the message is located.

From the list, select the message you want to delete. The contents of the message are displayed
in the information view.

3. Select Delete from the Edit menu, or press the Delete button on your keyboard.

A confirmation message box opens, click Yes to delete the message.

Note:
To delete all messages, click Select All from the Edit menu before you select Delete.

Folder Management:

Sorting SMS:

1.
2.

Select the folder where the messages you want to sort are located.

Click the Date column heading to sort the SMS in ascending or descending date order.
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Moving SMS:

1.
2.

Select the folder where the message you want to move is located.

From the list, select the message. The contents of the message are displayed in the
information view.

Click Move to Saved Messages from the Messages menu. A progress dialog is displayed
informing you that the SIM card is being updated.

The selected message is moved.
Note:

To move all messages, click Select All from the Edit menu before you select Move to Saved
Messages.

Copy an SMS:

1.
2.

SIM Inbox is Full:

Select the folder where the message you want to copy is located.

From the list, select the message. The contents of the message are displayed in the
information view.

Click Copy to Saved Messages from the Messages menu. A progress dialog is displayed
informing you that the SIM card is being updated.

The selected message is copied.
Note:

To copy all messages, click Select All from the Edit menu before you select Copy to
Saved Messages.

When the GC79 Manager detects the SIM SMS storage is full, it displays X[ on the Status screen
and in the SMS Messages screen. You must move or delete some SMS from the SIM Inbox to free
storage space so that you can continue receiving new SMS from the network. To do this you can
either:

*  Move your SMS from SIM SMS to Saved Messages
» Right click on an SMS in SIM SMS and select delete.
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GC79 Manager Online Services Screen
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Online Services is a customised service offered by a network operators. This service is network or
subscription dependant. The Online Services screen provides a mechanism that allows applications
that exist on the SIM to interact and operate with the GC79. Typical services offered by network
operators include:

* sports scores

*  news

+ financial data

* horoscopes

+ interactive text game messages

Online Services are placed on your SIM card by your operator. GC79 Manager detects if these
services are on the SIM card and displays the icon if they are.

1. Click ﬁ to display the Online services screen. You can also select to display the Online
Services screen from the View menu.

|« GC79 Manager - Information - |EI|1|

File Edit Yiew Phonebook Messages Help

L & B X R G

el = e I e

 Information

Select | Back I

For Help, press F1 '— m ’_ ’_

The screen displays a menu of the online services offered by your network operator.

Click on the category you require and click Select.

More detailed choices are sometimes displayed, if necessary select the required option
and click Select.

The response may take various forms, depending on the network operator. For example,
the news headlines might be sent as an SMS, which will be delivered to the SMS inbox.

Online Services menus are sometimes used to provide a list of voice-based services such as directory
enquiries. If one of these is selected, you will not be connected because the GC79 does not support
voice calls.

Note:
Contact your operator to find out which services are available for your account.
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Troubleshooting

This chapter lists some problems that you might encounter while using your GC79. Some problems
require you to contact your service provider, but most of the problems you can easily correct

yourself.

GC79 Manager Icon Errors

=== appears
in the task bar

GC79 isn't present, please insert.

appears
in the task bar

Indicates that the GSM/GPRS radio is turned off. Right-click
the icon and select Turn GSM/GPRS Radio On.

===== gppears
in the task bar

Indicates that the GC79 cannot find a GSM network, there is no
network within range or the received signal is too weak. You have
to move to get a stronger signal.

A signal is
present but you
can’t connect

Indicates that a GSM network is present, but no GPRS service
is available. This can be caused by; no GPRS service in the area,
you are trying to roam on a network for which no GPRS roaming

in the task bar

to the GPRS agreement exists or there is a temporary fault on the network.
network Contact your network operator for more details.
Indicates that the wireless LAN radio is turned off. Right-click the
m icon and select Enable Radio.
appears

1"" appears

in the task bar

Indicates that the GC79 cannot find a wireless network, there is no
network within range or the received signal is too weak. You have
to move to get a stronger signal.

Software Errors

Grey menu
options in the
software
applications

Grey text indicates a function that is temporarily unavailable,
for example due to your subscription or due to a certain setting
which has not been turned on.

Troubleshooting
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GSM/GPRS Error Messages

General

Modem not Check that the radio is turned on.
responding....

Error

Dial-Up fails Try to connect again.

SIM Card Errors

Wrong PIN/
Wrong PIN2

You have entered your PIN or PIN2 incorrectly. Enter the correct
PIN or PIN2, and click OK. See SIM lock on page 39.

Codes do not
match

When you want to change a security code (for example your PIN)
you have to confirm the new code by entering it again. This error
occurs when the two codes, that you have entered do not match.
See Phone lock on page 38.

contact operator

PIN blocked/ You have entered your PIN or PIN2 incorrectly three times in
PIN2 blocked succession. To unblock, see SIM lock on page 39.
PUK blocked — |You have entered your personal unblocking key code (PUK)

incorrectly 10 times in succession. Contact your network operator
or service provider.

Wireless LAN Error Messages

54

Medium Cable
Disconnected

A number of possible causes:

* You have moved out of range of the wireless LAN signal. Move
back closer to the hotspot.

« The wireless LAN is switched off. Right-click the % icon
and select Enable Radio.

» The network transmission has been interrupted. Contact the
Network Administrator.
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Wireless LAN Performance and Connectivity Problems

Data transfer is sometimes very slow

Microwave ovens and some cordless phones operate at the same radio frequency as the GC79
wireless LAN adapter. When the microwave oven or cordless phone is in use, it interferes with the
wireless network.

Therefore, check for possible sources of interference in the path between the GC79 and the network
access point (AP).

Data transfer is always very slow

Some homes and most offices are steel-framed structures. The steel in such buildings may interfere
with your network’s radio signals, thus causing a slowdown in the data transmission rate. Try
moving your computers to different locations in the building to see if performance improves.

Computer is not communicating with the network

If your network has a wireless LAN access point, check all cables and make sure the power LED
on the front of the AP is green. Verify that all of the wireless network properties settings are correct;
see Create a Wireless LAN Connection on page 25.

Also, make sure that your computer is receiving a good signal from the access point; see Viewing the
Status of your Wireless Connection on page 28.

Network performance is really slow when the system is docked to a docking station
that has an active Ethernet port

This condition occurs if you dock your system into a docking station that has an active Ethernet port
while your GC79 is still active and connected to a wireless LAN access point. This is because
Windows must now handle two active network connections.

You must either disconnect the Ethernet cable from your docking station, or disable the wireless
LAN radio on your GC79.

To disable the GC79 wireless LAN radio, right-click the i icon and then select Disable Radio.

Note:
The radio is not automatically enabled when your computer next starts. To enable
the radio, right-click the ¥ icon and then select Enable Radio.
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Windows Error Codes

Windows® 98

56

disconnected
by the remote
machine during
dial-up

Error 619: An ISDN mode (V110 or V120) has been selected when creating
The port is a connection, but is not supported by the network.

disconnected |Select Analogue mode when creating the connection in the
during dial-up |Connection Wizard.

Error 629: Telephony settings are set to pulse dialling, change to tone dialling.
The port was

Check the dialling settings for the current location (In Control
Panel = Phone and Modem Options = Dialing Rules
Location = Edit) and change the Dial using setting to tone,

or (if Pulse is a necessity), create a new location called GC79
Anywhere and set the dialling to Tone. GC79 anywhere location
should then be used whenever you use the GC79.

Error 630:

The port was
disconnected
due to hardware
failure during

A Dial-up networking connection is already connected. Close the
connected dial-up and try again.

authentication
error during
dial-up

dial-up
Error 645: Incorrect APN or CID selected for network.
Internal Modify your Dial-up Connection, see Create a GPRS, HSCSD or

CSD Connection on page 21 for more details. Make sure that the
APN file contains the name of the access point your network
operator is using. See the support section on
www.SonyEricsson.com site for a full list of network

operator APNs.

Error 650: The
Remote Access
server is not
responding
during dial-up

Incorrect User ID and/or password. Re enter correctly.

Error 678:
Computer you
are dialling is
not responding

Either: Service is not supported by SIM (usually for CSD/HSCSD)
or the computer is not answering.

-_—

Check SIM settings with your service provider if necessary,

during dial-up

2 Make sure that the server you are dialling is OK,

3 Make sure that Analogue mode has not been selected with
57.6kbps data rate (V110 or V120 mode must be selected
and supported by the network).

Error 720: The service is not supported by the SIM, usually appears when
No PPP control |you are trying to connect to GPRS Internet. Contact service
protocols provider to enable GPRS Internet access on SIM card.
configured

during dial-up
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Windows® 2000

Error 619: An ISDN mode (V110 or V120) has been selected when creating
The port is a connection, but is not supported by the network.

disconnected Select Analogue mode when creating the connection in the
during dial-up |Connection Wizard.

Error 678: Either: Service is not supported by SIM (usually for CSD/HSCSD)
Computer you |or the computer is not answering.

are dialling is

not responding |1 Check SIM settings with your service provider if necessary.
during dial-up
2 Make sure that the server you are dialling is OK.
3 Make sure that Analogue mode has not been selected with
57.6 kbps data rate (V110 or V120 mode must be selected and
supported by the network).
Error 691: The domain name entry is incorrect.

Access denied,
user name and
password
incorrect on the
domain during
dial-up

Correct the domain name entry or delete if not required.

Error 718: The
card was unable
to dial during
dial-up

This error indicates a PPP conversation started, but it was
terminated because the remote server did not respond within
an appropriate time. This can be caused by poor line quality or
a problem with the server (ISP). This error can occur when your
modem has connected to the ISP and has sent a username and
password, but there is no response from the server.

Wait a few minutes and try again.

All Windows® Operating Systems

Error 734: The PPP link
control protocol was
terminated during dial-up

The APN entry is incorrect, the signal is weak or the
connection is lost whilst dialling.

See the support section on www.SonyEricsson.com
site for a list of network operator APNs.

Error 678: Computer
you are dialing is not
responding during dial-up

Either: Service is not supported by SIM (usually for CSD/
HSCSD) or the computer is not answering.

Check SIM settings with your service provider if necessary.
Make sure that the server you are dialing is OK.

If you are unsure which speed to choose from the Speed
tab, start with Analogue 9600, and check to see if it works.
Once your connection works on Analog, you can try the
V110/V120 settings to see if faster speeds are available.
V110/V120 also connects faster than analog. When
roaming you may need to repeat this procedure to adapt
your settings to the capability of the local network operator.

Troubleshooting
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Connection Failed or
Activation Failed. Please
contact your Service
Provider.

No specific reason for failure is available. Wait a few
minutes and try again. If you continue to get this error
check your connection settings or call your service provider
for help.

Connection Failed. Invalid
APN. Please check and
enter the APN again.

The APN entry is incorrect, the signal is weak or the
connection is lost whilst dialing. See the support section on
www.SonyEricsson.com site for a list of network operator
APNSs or contact your service provider.

Connection Failed. Invalid
User Name or Password.
Please check and enter the
User Name and/or
Password in your
connection profile.

Choose to modify your connection in the Connection
Wizard. Go to the User ID screen and re enter the User
Name and Password given to you by your service provider.
If you were not supplied with a User Name and Password
leave the fields blank. Contact your service provider if you
continue to have problems.

Connection Failed. Invalid
Profile. Please check and
re-enter your connection
profile information, and try
again. If the problem
continues please contact
your Service Provider.

Your service provider doesn't recognise you. Check the
setting you have entered to create your connection. If you
still get the error contact your service provider and check
you have GPRS Internet enabled on your subscription and
then setting you should enter to create a connection.

Disconnected from
Network

You have been disconnected from the network. Wait a few
minutes and try again. If the problem persists contact your
service provider.

Connection failed.
Temporary Network
problem.

Please try again. If the
problem continues please
contact your Service
Provider.

This error indicates a PPP conversation started, but it was
terminated because the remote server did not respond
within an appropriate time. This can be caused by poor line
quality or a problem with the server (ISP). This error can
occur when your modem has connected to the ISP and has
sent a username and password, but there is no response
from the server.

Wait a few minutes and try again.

Connection Failed. Not
authorised to access
network. Please contact
your Service Provider.

Your service provider doesn't think your authorised to
access their network. Check the setting you have entered
to create your connection. If you still get the error contact
your service provider and check your subscription.

Connection Failed. SIM

is invalid for GPRS service.
Please contact your
Service Provider.

Contact your service provider and request the GPRS
Internet subscription is activated for your SIM.

Connection Failed. Access
to network not allowed.
Please contact your
Service Provider.

Your service provider is not allowing you to access their
network. Check the setting you have entered to create your
connection. If you still get the error contact your service
provider and check your subscription.

Connection Failed.
Roaming not allowed.
Please contact your
Service Provider.

Contact your service provider to get your roaming
activated.
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Connection Failed. Please
try again. If the problem
continues please contact
your Service Provider.

You couldn’t connect to the network. Wait a few minutes
and try again. If the problem persists contact your service
provider.

Connection Failed. Service
not supported. Please try
again. If the problem
continues please contact
your Service Provider.

Your service provider is not allowing you to access their
network. Contact your service provider and check you have
the subscriptions required activated for your SIM.

Connection Failed.
Network Problem. Please
try again. If the problem
continues please contact
your Service Provider.

You couldn’t connect to the network. Wait a few minutes
and try again. If the problem persists contact your service
provider.

Troubleshooting 59



Additional Information

Sony Ericsson Support Web Site

At www.SonyEricsson.com/support you can find help and tips in a few clicks. The support site
gives you access to:

* the latest software updates
* tips on how to use your GC79 efficiently
+ function guides

+ additional help

Important Information

Please read this information before using your GC79.

Recommendations
* Always treat your product with care and keep it in a clean and dust-free place.

* Do not expose your product to liquid, moisture or humidity.

* Do not expose your product to extreme high or low temperatures.

* Do not expose your product to open flames or lit tobacco products.
* Do not drop, throw or try to bend your product.

* Do not paint your product.

* Do not attempt to disassemble your product. Only Sony Ericsson authorized personnel should
perform service.

* Do not remove the SIM.

Children

Do NOT allow children to play with your GC79. They could hurt themselves or others, or could
accidentally damage the GC79. Your GC79 may contain small parts that could be detached and
create a choking hazard.

Disposing of the Product

Your GC79 should not be placed in municipal waste. Please check local regulations for disposal
of electronic products.

Electronic Devices

Most modern electronic equipment, for example equipment in hospitals and cars, is shielded from
RF energy. However, certain electronic equipment is not, therefore:

Do not use your GC79 near medical equipment without requesting permission.
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Aircraft

Blasting Areas

The GC79 may affect the operation of some implanted cardiac pacemakers and other medically
implanted equipment. Pacemaker patients should be aware that the use of a GC79 very close to

a pacemaker might cause the device to malfunction. Avoid placing the GC79 over the pacemaker.
If a minimum distance of 15 cm (6" inches) is kept between the GC79 and the pacemaker, the risk
of interference is limited. If you have any reason to suspect that interference is taking place,
immediately turn off your GC79. Contact your cardiologist for more information.

If you use any other personal medical device, consult the manufacturer of your device to determine
if it is adequately shielded from external RF energy.

Turn your GC79 off in any facility where posted notices so require.

You MUST remove your GC79 before boarding any aircraft.

To prevent interference with communication systems and abide by the law, you must not use your
GC79 while the plane is in the air.

Do not use it on the ground without permission from the crew.

Turn off your GC79 when in a blasting area or in areas posted turn off two-way radio to avoid
interfering with blasting operations. Construction crews often use remote control RF devices to set
off explosives.

Explosive Atmospheres

Turn off your PC when in any area with a potentially explosive atmosphere. It is rare, but your PC
could generate sparks. Sparks in such areas could cause an explosion or fire resulting in bodily injury
or even death.

Areas with a potentially explosive atmosphere are often, but not always, clearly marked. They
include fuelling areas, below deck on boats, fuel or chemical transfer or storage facilities, and areas
where the air contains chemicals or particles, such as grain, dust, or metal powders.

Do not transport or store flammable gas, liquid, or explosives in the compartment of your vehicle,
which contains your PC and accessories.

Inserting and removing the SIM card — precautions against electrostatic discharge (ESD)

Do not touch the SIM card connectors. As a precaution, always make sure that the GC79 is already
in your hand before you insert or remove the SIM card.

Radio wave exposure and Specific Absorption Rate (SAR) information

This GC79 PC Card has been designed to comply with applicable safety requirements for exposure
to radio waves. These requirements are based on scientific guidelines that indicate safety margins
designed to assure the safety of all persons regardless of age and health.

The radio wave exposure guidelines employ a unit of measurement know as the Specific Absorption
Rate or SAR. Tests for SAR are conducted using standardised methods with the PC Card
transmitting at its highest certified power level in all used frequency bands.

Whilst there may be differences between the SAR of various cellular devices they are all designed
to meet the relevant guidelines for exposure to radio waves.
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SAR data information for residents in countries that have adopted the SAR limit recommended by
the International Commission on Non-Ionizing Radiation Protection (ICNIRP), which is 2 W/kg
average over ten (10) grams of tissue (for example European Union, Japan, Brazil and New Zealand).

The highest SAR value for this model PC Card when tested by Sony Ericsson, to the users body and
to the bodies of bystanders, is 1.23 W/kg (10g).

SAR data information for residents in countries/regions that have adopted the AR limit
recommended by the Institute of Electrical and Electronic Engineers (IEEE), which is 1.6 W/kg
averaged over one (1) gram of tissue (for example USA, Canada, Australia and Taiwan).

The highest SAR value for this model PC Card when tested by Sony Ericsson, the users body and
to the bodies of bystanders, is 1.084 W/kg (1g).
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Technical Specifications

Product name GC79

PC Card Type 32-bit Cardbus

System WLAN 2.4GHz ISM band
E-GSM 900
GSM 1800
GSM 1900

Services supported WLAN: 802.11b
GSM: CSD, HSCSD, GPRS, SMS, Fax
Speech services are not supported

SIM Card Small plug-in card, 3V type

SIM Lock supported

Regular (non-GPRS-aware) and GPRS-aware
SIMs supported

Type Number FAE-1021011-BV

Exterior Description

Size PC Card Type I
Card part: 85.6 mm x 54.0 mm x 5.0 mm
Extension part: 15.4 mm x 54.0 mm x 10.5 mm

Weight 36g excluding SIM card
Battery Powered via the PC card slot; uses laptop battery
Antenna WLAN and GSM antenna integrated in the 15 mm

card extension

Ambient Temperatures

Operating ‘ -10 to 55 degrees C

Storage ‘ -20 to 65 degrees C

Electrical Characteristics

Supported Voltages 3.3V + 10%
Nominal Operating Voltage 3.6V
Standby Current 4.2mA
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Operating System Support

Supported Operating
Systems

Microsoft Windows® 98SE
Microsoft Windows® Me
Microsoft Windows® 2000 (SP2)
Microsoft Windows® XP

Minimum PC
Specification

Processor size as recommended by Microsoft for

the version of Windows® in use
30 MB free disk space

Drivers

Supplied Software (on CD-ROM)

GC79 Manager

Microsoft WHQL-approved for Windows 2000 and XP

‘ Status, SMS, Address Book and Settings

Documentation

GSM Performance and technical characteristics

64

User Manual
AT Command Reference

Dimension GSM 900/ GSM 1800 GSM 1900
E-GSM 900

Frequency TX: 880 — 914 MHz TX: 1710 — 1785 MHz TX: 1850 — 1910 MHz

Range RX: 925 — 959 MHz RX: 1805 — 1880 MHz RX: 1930 — 1990 MHz

Channel 200 kHz 200 kHz 200 kHz

Spacing

Number of 175 Carriers * 8 374 Carriers * 8 299 Carriers * 8

Channels (TDMA) (TDMA) (TDMA)

Modulation GMSK GMSK GMSK

TX Phase 5 degrees (RMS) 5 degrees (RMS) 5 degrees (RMS)

Accuracy 20 degrees (Peak) 20 degrees (Peak) 20 degrees (Peak)

Duplex 45 MHz 95 MHz 80 MHz

spacing

Frequency 0.1ppm 0.1ppm 0.1ppm

Stability

Transmitter 33 dBm Class 4 30 dBm Class 1 30 dBm Class 1

RF Power 2 W peak 1 W peak 1 W peak

Output

Transmitter | 500} 5002 5002

Output

Impedance

Transmitter According to GSM According to GSM According to GSM

Spurious specification specification specification

Emission
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Receiver -102 dBm -102 dBm -102 dBm

RF Level

Receiver <= 10+ (Static Ch.) <= 10+ (Static Ch.) <= 10+ (Static Ch.)
RX Bit <= 3% (EQ50 ch) <= 3% (EQ50 ch) <= 3% (EQ50 ch)
Error Rate

GSM Features Supported

ME SIM Lock Yes

Online Services SIM-AT Class 1b (Class 2 without call control.)

USSD Support is provided via AT commands; No MMI is provided
Speech Coding Not applicable (GC79 does not support speech services)

CSD technical data

Standards AT commands industry standard ETSI 07.05, 07.07 and
07.10, V.25ter command set supported

CSD Data Rates 9.6 kbps or 14.4 kbps depending on the GSM network

Compression MNP5 (Increases data rate up to 2x depending on data type)

V.42bis (Increases data rate up to 4x depending on data type)
GSM network support required for compression

Error Correction End to End MNP2 and LAPM (V.42)
RLP
Requires GSM Network support

GSM/ISDN According to V.110 and V.120

HSCSD Maximum Data Rates (kbps)

9.6 kbps per | 14.4 kbps per
timeslot timeslot
4+1 | RX 38.4 57.6
TX 9.6 14.4
3+2 | RX 28.8 43.2
TX 19.2 28.8

The speeds given are maximums, Sony Ericsson cannot guarantee how fast your network
will operate.
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GPRS technical data
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GPRS Specification SMG31bis
SMG
Data Rates Multislot class 10 supported (see table below)

Coding schemes: CS-1, CS-2, CS-3 and CS-4

Mode of Operation

Class B (attaches to both GSM and GPRS at the same time;
data connection is established using CS (CSD/HSCSD) or
GPRS) The user may select CSD, HSCSD or GPRS modes
via Dial-Up Networking configurations in Windows®

R Reference Point

Physical layer: RS232 virtual COM port
Authentication mechanisms PAP and CHAP supported

Attach Modes

GPRS attach

GPRS detach

Combined attach (CS+GPRS) (CCCH)
Combined detach (CCCH)

Combined attach (CS+GPRS) (PCCCH)
Combined detach (PCCCH)

Network Modes

Network Modes 1, 2 and 3

R Reference Point

Physical layer: RS232 virtual COM port
Authentication mechanisms: PAP and CHAP supported

IP Connectivity

PDP type IP is supported
IPv4, terminated in Windows® DUN

SMS over GPRS

Mobile Originated and Mobile Terminated

QoS

Support for all 4 classes
QoS negotiation

PDP Context

Up to 10 PDP context details are stored in GC79 Manager.
PDP Context description edited via supplied Wizard or
AT-command

Simultaneous PDP contexts not supported

Network initiated PDP context activation, modification and
deactivation

Collision of MS and network-initiated PDP context activation

SIM

Support for GPRS aware as well as non-GPRS-aware SIMs

Compression

TCP/IP Header Compression

V42bis
GPRS Encryption GEA1
GPRS Frequency Supported
Hopping
GPRS IP allocation Dynamic
Static
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GPRS Maximum Data Rates

Cs-1 CSs-2 CSs-3 CS-4

9.05 kbps 13.4 kbps 15.6 kbps 21.4 kbps
4+1 |RX | 36.2 53.6 62.4 85.6
TX | 9.05 134 15.6 214
3+2 |RX |27.15 40.2 46.8 64.2
X | 18.1 26.8 31.2 42.8

Speed achieved depends on the Coding Scheme supported by the GSM Network. The speeds given
are maximums, Sony Ericsson cannot guarantee how fast your network will operate.

At the time of writing, CS-2

SMS Technical Data

Concatenated SMS

is the most commonly used coding scheme.

Yes.

SMS Cell Broadcast

Supported in GC79 Manager and by AT Commands
(excluding Cell ID)

SMS Immediate
Display

Supported in GC79 Manager and by AT Commands

Character Sets

Unicode support for Chinese

SMS interface

GC79 Manager
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Software Upgrade

PC Card software

upgrade

PC GC79 Manager

Fax Technical Data

Via secure internet download (Sony Ericsson Update
Service) or at a Sony Ericsson Service Points.

Internet download.

Machine groups

Class 2, Group 3 and 4

Speed

9.6kbps

Verified applications

WLAN Technical Data

Microsoft Fax (Windows 2000 and XP; may require

installing), Symantec® and Winfax® PRO 10® (not
supplied).

Standard

IEEE 802.11b

Maximum speed

11Mbps

Frequency band

2.4GHz ISM band

Modes

Infrastructure (connect to an Access Point)
Ad-hoc (connect in an informal network of machines)

Security and
Authentication

Radio power output

WEP: 40 and 104 bits

802.1X (TLS and TTLS)

EAP-SIM (when standard is approved)

EAP-TLS, EAP-LEAP, EAP-PEAP, EAP broadcast
key, EAP MID-5 challenge

AT+CSIM command support

GSM900 Class 4 2w
GSM1800 Class 1 1w
GSM1900 Class 1 1W
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Supported Languages

Quick Start Guide
PC Software
User’s Guide (PDF)

English (EN)

Danish (DA)

Dutch (NL)

Finnish (FI)

French (FR)

German (DE)

Italian (IT)

Norwegian (NO)
Spanish (ES)

Swedish (SV)
Portuguese (PT)
Turkish (TR)

Traditional Chinese (ZT)
Simplified Chinese (ZS)

AT Command
Reference (PDF)

English

Additional Information
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License Agreement

Term

License

Any use of the enclosed compact disc, diskette or any other media including upgrades thereof
(“the Software”) shall be in accordance with the below stated license terms and conditions.

By opening the sealed Software package and/or using the Software you agree to be bound by
the terms and conditions stated below. These terms and conditions are binding and create a legal
obligation (the “License Agreement”) between you (the “Licensee”) and Sony Ericsson Mobile
Communications AB (the “Vendor”).

The Software licensed hereunder may be delivered in an inseparable package also containing other
software programs than this particular Software (e.g. bundled with other software). As a safeguard
you should not in any way use the other software programs before reading the specific license terms
and conditions of such other software.

License
You are hereby granted a non-transferable, non-exclusive right to use (“License”) the Software.

You may only (a) use this Software on one single computer at a time; (b) physically transfer the
Software from one computer to another if the Software is used only on one computer at a time
and provided you remove any copies of the Software from the computer from which the Software
is being transferred and/or on which it was originally used; (c) if necessary, make copies of the
Software solely for purposes of backup. The copyright notice must always be reproduced and
included on a label on any backup copy.

You may not according to the EC Council Directive of May 14, 1991 on the legal protection of
computer programs (91/250/EEG) (the “Software Directive”) distribute any copy of this Software
or its documentation to others; nor modify, rent, lease or grant any rights to this Software whatsoever
to another person or entity. In addition, you may not translate, reverse engineer, decompile,
disassemble, reproduce or otherwise alter or modify the Software, its source code, documentation
nor disclose any information designated as confidential or proprietary at the time of disclosure or,
information which by its nature, is confidential or proprietary.

Your License remains effective from the date of your cash receipt/proof of payment until terminated.
You can terminate your License at any time by destroying the Software together with all copies of
the Software in whichever form they may be. Your License will automatically terminate without
prior notice if you fail to comply with any term or condition of this Agreement. In the event of
termination of your License you must immediately destroy all copies of the Software in whichever
form they may be.

Limited Warranty

70

Vendor warrants the media on which the Software is provided, to be free from defects in materials
and workmanship under normal use for ninety (90) days after the date of your cash receipt/proof of
payment. The Vendor's and its suppliers' entire liability and your exclusive remedy under this
warranty will at Vendor's option be (and provided you return the Software to an authorized reseller/
supplier together with a copy of your cash receipt/proof of payment), to replace the disc(s)/
diskette(s) or refund the purchase price and terminate this Agreement including the License.
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Except for the above express limited warranties, Vendor and its suppliers do not provide nor do you
receive any warranties or conditions whether express, implied, statutory or otherwise and Vendor
and its suppliers specifically disclaim any implied warranties of satisfactory quality and/or fitness
for a particular purpose. If your jurisdiction does not allow limitations on implied warranties to
consumers, the above limitation may not apply to you.

Vendor does not warrant that your use of the Software will be uninterrupted or error free. You
assume full responsibility for the selection of this Software and your selected hardware and for the
Software and hardware together achieving your intended results, as well as for any installation or
use of or result obtained from the Software.

Intended use

The Software shall be used in accordance with the instructions and for its intended use and purpose
only. The Software or part thereof may not be used in e.g. life support systems, nuclear facility
applications, nor for the purposes of missile technology, chemical or biologized industry, flight
navigation or communication of air, ground support equipment or other similar business or for any
other purpose where any failure by the Software to perform may result in personal injury, death,
damage to tangibles or the environment.

Limitation of liability

In no event shall Vendor or its suppliers be liable for any indirect or consequential losses or damages
whatsoever irrespective of the cause for such losses or damages, including loss of data, loss of
business profits or revenue, or any business interruption arising out of the use of or inability to use
this Software. Vendor and its suppliers' total liability under this Agreement shall be limited to the
amount actually paid by Licensee for the Software.

Disputes and Governing Law

The validity, construction and performance of this Agreement shall be governed by the laws of
Sweden. All disputes, differences or questions between the parties with respect to any matter
arising out of or relating to this Agreement shall be finally settled under the Rules of Conciliation
and Arbitration of the International Chamber of Commerce, in Stockholm, by three (3) arbitrators
appointed in accordance with the said Rules. The proceeding shall be conducted in the English
language.
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Declaration of Conformity

We, Sony Ericsson Mobile Communications AB of
Nya Vattentornet

S-221 88 Lund, Sweden

declare under our sole responsibility that our product,
Sony Ericsson type FAE-1021011-BV,

and in combination with our accessories, to which this declaration relates is in conformity with the
appropriate standards 3GPP TS 51.010-1, EN 301489-7 and EN 60950, following the provisions of,
Radio Equipment and Telecommunication Terminal Equipment directive 99/5/EC with
requirements covering EMC directive 89/336/EEC, and Low voltage directive 73/23/EEC.

C€ 0682

Basingstoke, August 2003

Place and date of issue

-

Anders Franzén

Corporate Vice President M2M Com
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FCC Statement

FC

Before a modem is available for sale to the public, it must be tested and certified to the FCC that
it does not exceed the limit established by the government-adopted requirement for safe exposure.
The tests are performed in positions and locations as required by the FCC for each model. Body
worn measurements are made while the product is in use and worn on the body with an Sony
Ericsson accessory. The design and composition of an accessory can affect the body worn SAR
(Specific Absorption Rate) levels for the modem card. The distance used in the SAR Test Report
for this device is 4mm.

Sony Ericsson has not measured, and makes no representation about, the body worn SAR levels
when the modem card is used with non-Sony Ericsson accessories.

This device complies with Part 15 of the FCC rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) The device must accept
any interference received, including interference that may cause undesired operation.

FCC-ID: PY7F1021011
IC: 4170B-F1021011
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Appendix A - GSM Connection Parameters

General Connection Parameters for CSD/HSCSD and GPRS

Required Useful information

Telephone Number you need to dial to reach your service provider. Use the full

number or number including country code and area code, e.g. +46 33 555 2525.

Access Point Or

Name (APN) The APN server resource to contact, for example, Interent.operator.net -
to connect to the Internet via the mobile operator’s or your corporate
Intranet via a VPN.

Bearer You will need to know the bearer capability provided by your service

capability: provider, so you can select the appropriate option during set up.

CSD, HSCSD

or GPRS?

CSD Network
Speed

If you intend to create connections via CSD contact your network operator
and check the supported speeds.

HSCSD Network If you intend to create connections via HSCSD contact your network

Speed operator and check the supported speeds.

Username The username your service provider gave you when the account was set
up. Some dial-up accounts do not require a Username, in this case leave
the field blank.

Password Password associated with the username, given to you by the service

provider. Some dial-up accounts do not require a Password, in this case
leave the field blank.

IP assignment:
Server / Static

An ‘address’ that the service provider knows you by and uses to route
information to and from your GC79. Your IP address will either be:
Server - assigned by the service provider when you connect.

Static - assigned once by the service provider or the IT Manager.

If your IP address is Static you must enter it into Own IP address fields
which is available when you select Details in the Connection APN dialog.

DNS
assignment:
Server / Static

This tells the GC79 where to find the service provider's DNS Service.
DNS translates addresses such as www.sonyericsson.com to the numeric
IP address so that the information can be accessed.

Like IP assignment above, the DNS can be static or allocated by the
service provider when you connect. If static is selected additional fields
need to be completed containing the static information.

Own IP address

Only required if the IP assignment is static.
Format example: 123.9.45.3
Do not enter any leading Os when typing in IP address.

Primary DNS Only required if the DNS assignment is static.
Format example:123.9.45.2
Secondary DNS Only required if the DNS assignment is static.

Format example: 123.9.45.1

Access Point
Name (APN)

If the APN is set to default you will have to enter the name of the access
point your network operator is using.
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CSD/HSCSD Specific Parameters

Required

Useful information

Preferred
Connection
Speed (bits/s)

Select your preferred network connection speed from the drop down
list provided:
9600, 14400, 19200, 28800, 38400, 43200* or 57600*

Connection
Mode

Select the method you want to use to connect to the network from
the options provided:
analogue, ISDN V.110 or ISDN V.120

Compression

Use to speed up data transfer. You can select to Enable Data
Compression and Header Compression.

Callback
Number

Enter the number the a callback should be made to. You can only use
Callback if you are connecting to a source that gives permission for
callbacks to be made, for example your company server.

* Only available with ISDN V.110 or V.120 connection mode.
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Appendix B - Windows Log on using a GSM/GPRS
Dial-up Connection

The GC79 PC Card supports the Windows Log on using dial-up connection feature.

To log on to Windows using a GSM or GPRS dial-up connection the GC79 PC Card must be inserted
and the radio enabled before you log on. To enable the radio prior to logon, select Enable radio
immediately when card inserted checkbox on the Radio Power preferences tab, see Radio Power
Tab on page 17 for more details.

Important!
Never start your PC in this mode if you are in a location where mobile devices shouldn’t
be used, for example, on an aeroplane, in hospital or near a blast site.

Only check this option if you need to log on to a Windows Domain via a wireless dial-up connection.
This will permit the GC79 to register with the GSM network and establish a connection when the
Windows logon screen is displayed.

Note:

It is not possible to display network status or signal strength during the Windows logon
procedure, so you should allow enough time for the GC79 to find and register with the network
prior to attempting to log on.

The dial-up connections available to the Windows Logon must have been created by a user account
with Administrator privilege and designated For all users. This must be done using the Windows
Network Connection Wizard, because the GC79 Manager can only create connections for the
current user ID. Normally the Windows Logon using dial-up connection will be using a CSD/
HSCSD session to a corporate network, so that the logon credentials can be validated by a
Windows Domain Server.

Note:

A HSCSD networking session will require some additional settings to be added to your ini
string, see Appendix D- Initiating a HSCSD Connection from Outside the GC79 Manager on
page 79.

There may be special circumstances where a GPRS dial-up connection is required for logon.
To create a GPRS dial-up connection, follow these steps:

1. Create the Windows dial-up connection using the Windows Network Connection Wizard.
For the telephone number, use *99***3#,

2. Set the GPRS context parameters in the GC79 PC Card.
Open a Windows Hyperterminal session on the same port as the GC79, running at 115Kbps,
and type in the following AT Command.

AT+CGDCONT=3,“IP”,“<AccessPointName>",*,0,0
where <AccessPointName> is the name of the special GPRS access point for your corporate
GPRS service.

Note:
In this example, we used GPRS Context 3. There are 1-10 possible contexts supported by the
GC79 PC Card (1..8). Context ID 2 is reserved for connections created by the GC79 Manager.

Refer to the GC79 AT Commands Manual or contact your service provider for further assistance.
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Appendix C - Changing the GC79 Wireless LAN

Adapter Properties

vk v

Select Device Manager

Click the Start button.

Select Settings =+ Control Panel.
Click System.
Select the Hardware tab.

Network adapters =@ 802.11b Network Adapter

Advanced.

To change the value for any of the listed properties, click the property and then change the value in
the Value box by either selecting a new value from the drop-down list or by typing in a new value,
as appropriate.

Note:

It is strongly recommended that the values are only changed by network administrators
or technicians with wireless LAN experience.

Item Useful information

IBSS Channel Selects the independent basic service set (IBSS) channel number on

Number which to operate. The GC79 comes preset for use on channels 1-11.
These values are legal in most countries. Some countries allow use on
more channels. If you travel to one of these countries, you may change the
value for IBSS Channel Number to 12 or 13.

Locale Selects the operating characteristics that comply with the regulations

that apply in a particular country. Before connecting to a wireless network,
you should verify that the Locale value is correct. If you travel to different
countries with your GC79, you should change the Locale value to suit.

If the destination country is not listed, change the Locale value to
Worldwide. Reset the Locale value after returning.

Residents of both Canada and the United States should use the value USA.

For details of an easier way of changing this value, see GC79 Wireless
Control menu on page 15.

Radio Enable/
Disable

Enables or disables the GC79 wireless LAN radio. This may be necessary
necessary at times to turn off the radio to comply with restrictions
prohibiting the emission of radio signals, such as during takeoff and
landing onboard a commercial aircraft.

For details of an easier way of changing this value, see GC79 Wireless
Control menu on page 15.

Rate

Sets the transmission rate. The default value is Use best rate. This
automatically adjusts the data rate to the optimal rate based on the
capabilities of the other clients and access points.

Fragmentation

The threshold at which the IEEE 802.11 adapter breaks the packet into

Threshold multiple frames.

Locally This is used to override the MAC address of the GC79 wireless LAN
Administered network adapter.

MAC Address

PLCP Header

This is used to set the header type used for CCK rates. The type can be
long, or auto (short / long).

Power Output

Sets the percentage of the maximum available output power to be used.
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Power Save
Mode

This is used to put the GC79-enabled computer into the IEEE 802.11
Power Save mode. In Power Save mode, the radio is periodically powered
down to conserve power. When in Power Save mode, packets are stored
in the AP until the PC comes on.

RTS Threshold

If the number of frames in the data packet is at or above the RTS
Threshold, a request to send/clear to send handshake is turned on before
sending the data packet. The default value is 2347.

Appendix C - Changing the GC79 Wireless LAN Adapter Properties




Appendix D- Initiating a HSCSD Connection from
Outside the GC79 Manager

The HSCSD speed is normally entered in the GC79 Manager Connection Wizard. The specified
speed is requested when the Connect button is pressed in the Status screen of the GC79 Manager.

In exceptional cases you may need to initiate an HSCSD call from outside the GC79 Manager
(for example, Safe Removal of the GC79 on page 20 and Connection on page 36) the HSCSD
speed must be specified by placing additional commands in the GC79 Wireless Modem properties.

4,

Note:
GC79 Wireless Modem properties settings will override any settings for connections initiated
from the GC79 Manager.

. To access the GC79 Wireless Modem properties, select Start = Settings =+ Control Panel

Phone and Modem Options.
Select the Modems tab.
Select the Sony Ericsson GC79 Wireless Modem and click Properties.

Click the Advanced tab and enter the HSCSD setting into the Extra initialization
commands: field.

To set the connection to analog 28.8 place +CBST=7,0,1;+CHSN=4,0,0,12 in this field,
Click OK.

2

i |

Genera\l Diagnostics  Advanced | ]

Extra Setting:

Extra initiglization commands:
+CBST=7.0.1:+CHSN=4.0.0,12

[ Advanced Port Settings
Change Default Preferences.

0k Cancel |

C=
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The table below shows the AT Commands for each speed and bearer:

Speed +CBST +CHSN

Analog mode

9.6 7,0,1 1,0,0,12
14.4 7,01 2,0,0,12
19.2 7,01 3,0,0,12
28.8 7,0,1 4,0,0,12
38.4 7,0,1 5,0,0,12

ISDN mode V.110

9.6 71,01 1,0,0,12
14.4 75,0,1 2,0,0,12
19.2 79,0,1 3,0,0,12
28.8 80,0,1 4,0,0,12
38.4 81,0,1 5,0,0,12
43.2 81,0,1 6,0,0,12
57.6 81,0,1 7,0,0,12

ISDN mode V.120

9.6 39,01 1,0,0,12
14.4 43,01 2,0,0,12
19.2 47,01 3,0,0,12
28.8 48,0,1 4,0,0,12
384 49,0,1 5,0,0,12
43.2 50,0,1 6,0,0,12
57.6 51,0,1 7,0,0,12
Note:

Speeds relate to the receive (downlink) speed. When connected at 43.2 or 57.6,
uplink (transmit) speed will be 14.4 maximum. At lower receive speeds, transmit speed
can be up to 28.8.
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Glossary

802.11

A standard developed by the IEEE. The 802 family
of standards relates to local and wide area networks.
802.11 refers to WLAN standards.

802.11b

The IEEE standard relating to WLAN operating at
2.4GHz and having a maximum speed of 11Mbps.
802.1X

802.1X is the security layer in the 802 standard.

802.3
The IEEE standard for Ethernet based wired networks.

AP

Access Point. A device which provides wireless 8§02.11
access to a wired network (typically 802.3 Ethernet).
The user can see available APs in the vicinity and
(depending on security/authentication requirements)
connect to the internet or intranet services they offer.

A group of APs can be networked to provide service in a

wider area, or to break down traffic into smaller hotspots.

APN

Access Point Name. Used in GPRS to define services
to which the terminal can connect. For example, Internet,
WAP, MyCompany.

Bearer

Path over which data flows. Specifically in CSD and
HSCSD, the type of telephony link from the GSM
network to the server - V PSTN or ISDN.

bps

Bits per second - rate of data flow.

COM Port

Defines a serial/RS-232 port within the Windows®
environment. May be physical (COM1 port on the rear
of the PC) or virtual (COMS port communicating with
a PC card modem)

CS

Circuit Switched. Connection from A to B which has a
fixed bandwidth and is maintained over a period of time,
for example a voice telephone call.

CS-1to CS-4

Coding Scheme. Determines the data rate per timeslot
in GPRS.

csD

Circuit Switched Data. CSD is a GSM service providing
a CS data connection at a rate of 9.6 or 14.4 kbps.

DUN

Dial-Up Networking.

e-GSM

Extended GSM. New frequencies specified by the
European Radio Communications Committee (ERC)
for GSM use when additional spectrum is needed
(Network-dependent). It allows operators to transmit
and receive just outside GSM’s core 900 frequency
band. This extension gives increased network capability.
ETSI

European Telecommunications Standards Institute.
www.etsi.org

GGSN
Gateway GPRS Support Node.

GPRS

General Packet Radio Services.

GSM

Global System for Mobile Communications. GSM is the
world’s most widely-used digital mobile phone system,
now operating in over 160 countries around the world.
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GSM 900

The GSM system family includes GSM 900, GSM 1800
and GSM 1900. There are different phases of roll-out for
the GSM system and GSM phones are either phase 1 or
phase 2 compliant.

GSM 1800

Also known as DCS 1800 or PCN, this is a GSM digital
network working on a frequency of 1800 MHz. It is used
in Europe and Asia-Pacific.

GSM 1900

Also known as PCS. Refers to a GSM system running in
the 1900MHz band. Used in the USA and Canada, for
instance.

Hotspot

An area in which a WLAN service exists.

HSCSD
High Speed Circuit Switched Data.

HTML
HyperText Markup Language.

HTTP
HyperText Transfer Protocol.

IEEE

Institute of Electrical and Electronic Engineers.

ISDN

Integrated Services Digital Network. Can provide
circuit-switched data connections in multiples of
64 kbps.

ISP

Internet Service Provider.

kbps

Kilobits per second - rate of data flow.

LAN
Local Area Network.

MAC

Media Access Control.
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ME
Mobile Equipment.

MO

Mobile Origination. For example, an SMS message
sent from a mobile terminal.

MMI

Man-Machine Interface.

MS
Mobile Station.

MT

Mobile Termination.

NDIS

Network Driver Interface Specification. A Windows
device driver interface enabling a single NIC to support
multiple network protocols. For example, TCP/IP and IPX.
NIC

Network Interface Card.

OoTP

One Time Password. A security procedure where the
user is given a new password for each login.

PC

Personal Computer.

PCS

Personal Communications Services, often used
to describe GSM 1900 networks.

PC Card

A card having physical and electrical characteristics
specified by PCMCIA providing extra functionality
when inserted into a laptop PC. Typical examples are
modems and network cards. Type refers to the thickness
of the card. The GC79 is type II.

PCMCIA

Personal Computer Memory Card International
Association — defines specifications for PC Cards.
WWW.pcmceia.org
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PDP

Packet Data Protocol.

Phone book

A memory in the SIM card where phone numbers
can be stored and accessed by name or position.
PSTN

Public Switched Telephone Network, for example
ordinary analogue phone line for speech and/or computer
modem.

RADIUS

Remote Access Dial-In Service. Facility at the ISP
or corporation to manage remote data connections.

RAS

Remote Access Service.

RX

Receive

SC
Service Centre (for SMS).

Service Provider

A company that provides services and subscriptions to
GC79 users.

SIM card

Subscriber Identity Module card — a card that must be
inserted in any GSM-based mobile terminal. It contains
subscriber details, security information and memory for
a personal directory of numbers. The card can be a small
plug-in type or credit card-sized, but both types have the
same functions. The GC79 uses the small plug-in card.

SMS

Short Message Service. Allows messages of up to 160
characters to be sent and received via the network
operator's message centre to a GC79.

TCP/IP

Transmission Control Protocol/Internet Protocol.

TCP/IPv4

TCP/IP Version 4. Most widely implemented form of
TCP/IP today having a 4 byte address format such as
212.161.127.136.

TCP/IPv6

Updated version of TCP/IP, having a much larger
address space and many enhancements.

TE

Terminal Equipment. Generic term for GSM terminals
such as phones and PC cards.

Terminal Adaptor

Generic term for the equipment terminating a digital
comms line such as an ISDN2 line. The GC79 is a
Terminal Adaptor since it interfaces to GSM digital
data services.

TLS

Transport Layer Security. Used by Web browsers,
for example.

X

Transmit

Type ll

Refers to thickness of a PC Card as defined in the
specification from PCMCIA.

URL

Uniform Resource Locator.

USSD

Unstructured Supplementary Services Data. Narrow-
band GSM data service. For example entering
*79*1234# might return the stock price for stock 1234.
V.110

ETSI standard for data over an ISDN circuit.

V.120
ETSI standard for data over an ISDN circuit.

VPN
Virtual Private Network.

WECA

Wireless Ethernet Compatibility Alliance. Also known
as the WiFi Alliance. A trade body for promotion of
802.11 technologies and which tests and certifies
products for WiFi inter-operability.

www.weca.net
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WEP

Wired Equivalent Privacy. An encryption service built
in tot many 802.11 products intended to make the
connection secure.

WiFi

Wireless Fidelity. The popular name for 802.11
technologies that have passed WiFi Certification
Testing, for which WECA is responsible.

WiFi Alliance

See WECA.

WLAN
Wireless LAN (Local Area Network).

WML

Wireless Markup Language. A markup language used
for authoring services, fulfilling the same role as HTML
does on the world-wide web. In contrast to HTML,
WML has been specifically designed to suit small hand-
held devices.

www

World Wide Web.

XML
Extensible Markup Language.
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Technical support 9, 60
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U
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